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Installing and Operating SU Podium V2
SU Podium V2 requires SketchUp 7 or 8. Windows version requires Windows XP, Vista or 7.
Mac version will require OS-X 10.6.x or above. The V2 engine is multi-threaded meaning it will
take advantage of all your CPU core's. You also need a reasonable amount of RAM to hold 3d
scene data. The more RAM you have, the more complex models you can render. If you have a
64 bit operating system, Podium will take advantage of all your RAM. For Windows there are two
versions, 32 bit and 64 bit. Mac is all 64 bit.

1. Install

The install process is straight forward and in most cases will require no input from the user. The
main thing to be aware of is which version of SketchUp you are using. When you purchase SU
Podium V2 from Cadalog, Inc's web store or from your reseller, you will receive a web page link
that has the SU Podium V2 versions to download. You will also receive a 16 digit license code. If
you need to reinstall SU Podium V2 for some reason, go to the Free Trial page and download
the free evaluation version and activate the trial version with your license code. Alternative, click
on this link to go to the Version 2 web page and download from here.

Note: Free Trial version users.You will not receive a license code. Instead, ignore the
Licene Manager dialog box that comes up, requesting you to enter a license. In the License
Manager dialog, you should see the amount of time left in your evaluation period. When
you render something for the first time, let the Process Scene process end and the License
Manager dialog box will go away.

Windows Install for SketchUp 7 or 8. You must have a Windows Administrator User
Account to install SU Podium V2. You can run the program without being an administrator
but to install it you must be have administrative privileges. Close SketchUp before starting
the install. Double click on the install file you have downloaded. An installation program will
start. The default install location for SU Podium V2 is \program files\google\google
sketchup 8\plugins\. Change the number 8 to 7 if you are installing for SketchUp 7. If you
have a 64 bit Windows operating system, the default location will be \program files
(x86)\google\google sketchup 8 (or 7)\plugins\. The installation will create a sub-folder in
the \google sketchup 8 (or 7)\plugins\ folder called SU_Podium_V2. There will also be a
ruby load file in the plugins folder called SU_Podium_V2.rbs. In addition,
SU_Podium_Browser.rbs file is installed. If you need to uninstall SU Podium V2, use the
Uninstall option from the All Programs ---->SU Podium V2 location.

Windows Users - Windows 64 bit version There is a SU Podium Version 2, Windows 64 bit
version. The Mac version is already a 64 bit version. When you purchase SU Podium V2
you will be sent a license code and a URL to download Windows, Windows 64 and Mac
versions of SU Podium V2. 32 bit version will work on any Windows 32 bit or 64 bit
computer. However, the 64 bit version supports more RAM memory. Therefore, it will
rendering much larger SketchUp files. If you have more than 4 gigabytes of RAM, you might
consider downloading and installing the Windows 64-bit version. Mac version is a 64 bit
version.

Mac Install for SketchUp 7. Close SketchUp before starting the install program. Double
click on the SU_Podium_V2_SU7_Mac.zip file that you downloaded. This will unzip the
install file. Double click on the install, package file. SU Podium V2 is installed in the
Macintosh HD\Library\Application Support\Google SketchUp 7\SketchUp\Plugins\. A new
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folder in the Plugins directory called SU_Podium_V2 is created as well as ruby load files
called SU_Podium_V2.rbs and SU_Podium_Browser.rbs. If you need to uninstall SU
Podium V2, move the SU_Podium_V2.rbs, SU_Podium_Browser.rbs and SU_Podium_V2
folder into the trash bin.

Mac Install for SketchUp 8. Make sure you purchase or upgrade the SU Podium V2 for
SketchUp 8. This only works on SketchUp 8. Close SketchUp before starting the install
program. Double click on the SU_Podium_V2_SU8_Mac.zip file that you downloaded. This
will unzip the install file. Double click on the install, package file. SU Podium V2 is installed
in the Macintosh HD\Library\Application Support\Google SketchUp 8\SketchUp\Plugins\. A
new folder in the Plugins directory called SU_Podium_V2 is created as well as ruby load
files called SU_Podium_V2.rbs and SU_Podium_Browser.rbs.

Mac Uninstall. If you need to uninstall SU Podium V2 from your Mac, go to your
Macintosh HD\Library\Application Support\Google SketchUp 8\SketchUp\Plugins\
folder and move the SU_Podium_V2.rbs, SU_Podium_Browser.rbs and
SU_Podium_V2 folder into the trash bin.

Mac OS-X 10.8.x Mountain Lion! Please note: Apple now requires software developers to
have Apple approved Digital Signatures for automatic installation on Mountain Lion OS-X
10.8.x. As of September 14, 2012, Cadalog, Inc. does not have Apple approved digital
signatures for SU Podium V2, SU Animate, EditInPlace, RenderAll Beta or Podium Walker
Beta. Cadalog, Inc. is in the process of receiving approval. However, this does not mean
that you can not install SU Podium V2, SU Animate, Podium Walker safely and securely.
Please click here to see how to install on Mountain Lion.

2. Activate your License

Activate your sixteen alpha numeric license code. If you are using the commercial version
of SU Podium, you will need to activate your 16 character license code to get the full
version working. You can register the license in two ways. First, you can pick License from
the SU Podium V2 pull down menu and activate your license. Second, when you click
render, you will be prompted to activate your license.

(If you are using the evaluation version, ignore this dialog box and wait for the process
scene to finish to continue to evaluate.)
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Once the license is registered, please restart SketchUp. This action will turn off the trial
mode of SU Podium V2.

Trouble shooting your install. One common problem reported is that after you install SU
Podium V2, the Podium pull-down and tool bar does not show up in SketchUp. Make sure
you restart SketchUp, if SketchUp was open during the install. There's typically one reason
why SU Podium V2 menus do not appear in SketchUp and that is to do with the installation.
Please click here to read about how to solve this issue.

3. Render process and getting started

After installing SU Podium V2 for SketchUp 7 or 8, you can access SU Podium V2 from the
SketchUp plug-ins pull down menu or from the SU Podium V2 tool bar.
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Before you render your first SketchUp model, get familiar with the Options dialog box and
the various settings that are controlled there. We also recommend that render a sample
model from here SU Podium V2 models pageas a way to test Podium.

To introduce yourself to V2's rendering process, do a quick render of your model. First click
on the Options menu from the pull down or the tool bar. In the preset pull down list, pick
Default.pps. This preset is not the best but the easiest to start with. In the Output tab, under
Dimensions, pick a Fixed size or the default Viewport size for the rendered image size.
Click the OK button. Then pick the Render menu from the pull-down or tool bar. A series of
sequences will happen after clicking on the Render icon or menu. If this is you first render,
you will be prompted to Activate your license.

(Ignore the License Activation dialog box if you are using the trial version.)

Processing Scene - this first step is where SketchUp geometry and textures are
converted to Podium's mesh modeler. If your SketchUp model is very big, this
process can take several minutes. Please read here if you find that Processing
Scenes is taking a very long time.

The OOPR or Podium Render Manager will also be launched during Processing
Scene. If you do not see see the Podium Render Manager dialog box, click on
OOPR from the Task Bar in Windows or Dock in the Mac. You will see a
message "receiving from network client" during Processing Scenes.

If OOPR is not getting launched, please read here about possible problems.

UV Mapping - is the 2nd step. This step is often so fast you will not see it.
Prerendering in progress. After UV Mapping, you will see an OOPR message that
says Prerendering is in progress and a percentage of completion.
Raytracing. Podium V2's raytracing is a high quality raytracing program and is one of
the fastest on the market. This will occur after Prerendering. From this point you can
Preview the rendering.
Resampling Edges. This is the final step and often takes longer than Raytracing. Most
of resampling is the anti-aliasing process which smooths out the edges of the
rendered image. The preset you choose from the Options menu controls the level of
anti-aliasing.

Once Raytracing starts you can click on the Preview menu in the Podium Render Manager
to view the render progress dynamically. The Preview image will be smaller than the final
rendered image. As a default, the final rendered image will be saved to the folder that the
SketchUp model is saved in unless you change the location for saved images to be saved
in. Please read about this in the Options section.

4. Download and test some ready made SketchUp models.

Click on this link to go to the SU Podium V2 models page. You can do download five render
ready SketchUp models to test results.

5. Where to get Support

The following Help pages will guide you through Installation and using and applying SU
Podium. Please take a moment and read through the Installation chapter if you are having
difficulty with the install. If you are having trouble finding your serial number, please take a
look at the FAQ section of this web site. There is a detailed description of how to find your
serial number. In addition, you can get support from the following areas:
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The SU Podium Forum - an active Forum with two or three experts online almost any
time.
E-mail support - support@cadalog-inc.com Please e-mail us with any question, any
time. You should get a reply within 24 hours. Usually, much faster. If you are
experiencing crashes please look at this check list before contacting support.
Upload your models. If you are having problems rendering your models, feel free to
upload them to our box.net account. Make sure you send and e-mail to us to let us
know you have uploaded a model.

Go to SUplugins.com Help page to find out Where to get support and upload
your model.

6. What version am I running?

If you are using SU Podium V2.9 or above, click on the About menu item in the
SU Podium V2 pull down menu. This will link to a web page which will display
the version number. If you do not have an About menu option, you are using a
version prior to SU Podium V2.9. SU Podium V2 users can get free updates
here - Current Version 2 page.

If you are using a version prior to V2.9, a quick way to see what version of SU
Podium V2 you are running is to use the Information Bar that gets attached to a
rendered image. You will need to turn on the information bar and render
something to see the version number you are running.

Open any model in SketchUp. For example, open one of the sample
models from the Sample Model download page.
Open the Options menu from the SU Plugins Toolbar and click on the
Environment tab. Click on the Info. Bar so that a check box appears next
to this item.
Click on the Render icon and render the model. A rendered image will get
saved to either the folder where the model is located or a folder of your
choice. Read about save locations here.
Open the image file and look at the black information bar at the bottom of
the image. On the left there is a Build item. The number next to Build
defines the version number of V2. For example, Build 6 would mean
Version 2.6.
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Support Check List for SU Podium V2
If you are experiencing install problems, crashes or freezing with SU Podium V2, before sending an email to
Support we would greatly appreciate it if you can run through this check list and answer as many of these
questions as possible. Send as much information as you can with your support questions.

SU Podium OS version - are you using Windows 32, Windows 64, Mac OS-X?
What version of SketchUp do you have?
Please do a simple model test. The easiest test is to create a cube in a new SketchUp file and render
it. Does it render? Youc can also download and open one of the sample models from this page and
click on Render. Are there any problems rendering the sample models?
SU Podium versions - which version number of SU Podium are you using? If you are experiencing
crashes, ignore this question.

If you do not know the version number, click here.

If you are experience render problem where Podium Render Manager starts but nothing is happening
please read this FAQ item.
Windows users - Do you have over 4 gb of memory and using a Windows 64 bit version of Windows
7? If so, please download and install the Win64 bit version of SU Podium V2.
Most often crashes occur due to a combination of lack of system memory and the size of the
SketchUp model and possibly the resolution output size you are rendering to. Here is a short memory
and model size check list:

Windows - go to Control Panel and click on System and report the memory amount and the CPU
information.
Mac - Go to About this Mac and report on memory amount and CPU information.
Open the "problem" model and go to SketchUp's Window, Model Info and check on statistics and
click on Show Nested Components. Report on the number of faces in the model. (Keep in mind
that if you have several hundred thousand faces you will need to be using the Win64 or Mac
version with over 4 gb of memory.)

Run Podium Tools on the model. Go to the SU Podium V2 menu, click on Tools and Analyse. This
may take a few minutes. Look at your lower left corner of your SketchUp viewport to see progress.
Please report on the results.
Tell us what image size you are trying to output to.
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Options Menu
Click here to watch the Introduction to V2 video which explains the user interface in detail.

The Options menu has important settings that allow you to choose presets, resolution size for the rendered
image, image file format (JPG/PNG/HDR), transparent, where to save your rendered images and various
Environment settings such as Physical Sky vs SketchUp Sky, sun exposure and intensity, caustic, clay and
soft omni lights.

1. Presets

There are three categories of presets that have been crafted for certain rendering environments. Presets
were created to control hidden variables that effect things like Physical Sky’s turbidity, sun brightness and
contrast, ray trace bounces, amount of ambient light, tone mapping variables, anti-aliasing, etc.
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The categories of presets are default, exterior and interior. The presets are saved in the Preset folder in the
SU Podium V2 folder. Presets can be opened and edited with a text editor if you know what you are doing.

This page does not describe how to edit the presets. If you do desire to edit the presets, visit the the Preset
Page. Presets have a file extensions of .pps. This means that your Windows Explorer or Mac OS may
confuse the preset file for a PowerPoint file. Make sure you open a preset with a text editor like Notepad.

The fastest raytracing preset is default. However, default preset has not been calibrate for exterior or interior
SketchUp environments. Default is a general purpose preset.

Interior and Exterior presets have been crafted for the SketchUp Interior or Exterior environment. Interior
would be defined as a model or scene that is indoors. Exterior would be primarily an outdoor environment.
There are four types of interior and four types of exterior presets.

Interior presets. Currently there are four which include the default, high, QMC and Preview versions.
The most widely used interior preset is the interior_default.pps. The interior presets have increased
levels of global illumination. The best use of the interior presets are with interior models. You will
notice that interior presets expose a lot of light. Therefore experimenting with this preset and how
much light is in the interior space that you are rendering is important. Please read here on Tips for
Interior Lighting.

The QMC presets are the highest quality but will take the longest to render. QMC presets are
good to get rid of blotches if you have a blotches problem. See here about blotches.

The Preview presets have minimize resampling phase which includes means very little anti-
aliasing so are good for quick previews but not for final renderings.

Exterior presets. Exterior presets are made for exterior renderings. Exterior presets are highly
recommended for exterior renderings that use sun and sky as a primary source for light. There are
default, high, QMC and Preview types of Exterior presets.

Exterior lighting is greatly effected by whether or not SU Podium's Physical Sky is used, whether
or not SketchUp Shadows are on (sun light), and the if Physical Sky is not on, how dark the
background color of the SketchUp environment is, the color of the textures. Please read the
section below on items in the Environment tab to understand your various sky options. Also read
about setting up your model for Exterior renderings here.

Please take a look at this FAQ section of the SU Plugins web site for information on sun and sky
brightness and how to best control this. Click Here.

Preset Alternatives. Take a look at the Presets page to see what other presets are available for download.

2. Resolution size, image formats and save

The full version will have Fixed sizes and Custom sizes for resolution. The trial version has limited resolution
sizes. Viewport resolution means the rendered image is restricted to your SketchUp viewport resolution
size. In other words, the image resolution will match the pixel size of your SketchUp viewport. For example,
if you have a 1600 X 900 pixel computer screen and the SketchUp viewport is full screen, then your
rendered image resolution will be close to 1600 X 900 pixels.

The choice of resolutions sizes include Fixed sizes or custom sizes. Fixed sizes are 230X150, 640X480,
1024X768, 2048X1536, 3076X2304, 4076X3304, Wide screen resolutions of 16:9 aspect ratios of
852X480, 1600X900, 1920X1080. Custom sizes mean that you can enter any pixel height and width such as
8000 X 5000. Keep in mind that you should chose pixels sizes that much the aspect ratio of your computer's
monitor if you want the entire SketchUp viewport to be rendered.
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SU Podium V2 gives you the option to choose PNG/JPG/HDR as saved image formats. You can save your
images to a folder of your choice if you choose Custom. Click on the Browse button to choose the folder you
would like to save your rendered images in.

There is no print feature in SU Podium. To print your rendered image, you need to use a image processing
program such as Paint Shop or Photoshop. Click here to read about printing your image.

3. Transparent

With the PNG format on, Transparent will create rendered images with alpha transparent backgrounds so
that you can easily add your own sky background image to rendered .png file in an image editor program.
Click Here for more detail on Transparent backgrounds

 4. Environment settings

Click on the above image to go to the Environment Settings page.

11 SU Podium V2 Help and Tutorials



Apply Material Properties
Click here to watch the material properties video tutorial.

Overview of the Materials dialog box
Diffuse, Transparency, Reflection sliders
Blur, Refraction, Bump
Light or LEM slider
Anti-Aliasing for materials
Materials Tutorial

Materials dialog box overview

Don't forget to click on Apply for properties to take effect

Reflections, refractions, bump maps, LEM lights and other properties are applied to a specific texture
globally in the model.

Select a SketchUp texture you want to apply Podium properties too. You can select the texture by selecting
the face that the texture is on or you can select the texture directly from the SketchUp Material browser.
When you make a texture selection, its name will appear at the top of the Podium Material Property dialog
box.

(Please Note: Textures that are assigned to curved surfaces or back side of faces, should be selected from
the SketchUp Material browser or with the i-dropper icon. These textures will not automatically appear in the
V2 material editor. Please see known issues below. )

Once a selection is made, apply the various Podium properties to the texture by using the appropriate slider.
This will turn the texture into a Podium material.
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Please Note: You must click on the Apply button for the properties to be applied to the material.

Diffuse, Transparency, Reflection sliders

Diffuse, Transparency and Reflections are connected to each other. The combined value of the three sliders
should equal 100% when applied to a texture. The default setting for non-transparent materials is 100%
diffuse. However, if you want to see direct reflections on that texture, move the Reflection slider to the right.
The Diffuse slider will automatically move left. Diffuse is reflection that does not bounce directly back to the
camera but reflects at an angle. An example of the difference between Diffuse and direct reflection might be
the reflection of a paved road. When it is dry, it has more diffuse reflection. When it is wet, it has more direct
reflections. You can not have 100% Reflection (direct) and 100% Diffuse. Otherwise the material will render
strangely.

Confused about Diffuse? Click Here

Transparency is the SketchUp transparency/ opacity property conveniently located here. It is not wise to
have a high transparency and a high reflection value. That is not real world and you renderings will look odd.
The rule of thumb is to combine the 3 sliders to make 100%.

Blur, Refraction and Bumps

Refraction is where light waves "bend" when passing through a material with a refractive index. A good
example of this is a straw placed at an angle in a glass of water. The water has a refractive index of 1.33.
The straw looks bent at the surface of the water. Although there is no such material as air in Podium, if there
was it would have a refractive index of 1. Version 2 has a list of preset refractive indexes for certain
materials. To use Refraction on a texture, select the texture and enter a refractive index. Check out a good
explanation of refraction here - Wikipedia
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Both Reflections and Refractions have a blur option. The render speed will slow down if you choose the blur
option but the reflections will look very realistic.

Bump Depth slider will allow you to apply bump maps to textures. Bump values are different to V1.x, and a
value of 1 produces an extremely subtle effect suitable for water.

Light Emitting Material

The Light slider in the material properties will apply LEM (Light Emitting Material) to the texture you have
selected. LEM lights are one type of artificial light source in SU Podium V2 and will create lights that emit
light in one direction away from the face of the texture. LEM lights are easy to create and are quick to
render. Light slider is the LEM light slider. Pick a texture and apply the light slider. This will turn that texture
into a LEM Light. You can pick a value from 1 to 100. The values must be whole numbers.

High Intensity check box is applied to the LEM Light. When High Intensity is on, single digit power values
should be used. Otherwise the LEM light will be extremely bright. In most cases, you will not need the High
Intensity option.

Hidden LEM is a feature that will hide the material and SketchUp face that the material is on in the rendered
image. The LEM light will be displayed but the SketchUp geometry and material will not be displayed in the
final image.

See more about artificial and natural lights in the Lights section of the Help pages.

Anti-Aliasing on Materials

Anti-aliasing is an image process that is used in SU Podium that subtly smooths the jagged edges of
objects in the image. In SU Podium, it is the last step in creating the photo-realistic image. It is a global
setting that is equally applied through out the image. The SU Podium presets determine how much anti-
aliasing will occur. For example the exterior_high and interior_high presets will apply a greater degree of
anti-aliasing than other presets. However, there are times, where you want some materials to have more or
less anti-aliasing that what the preset has determined. For example, you may have a 3D tree model that has
a leaf material applied to hundreds of leaves in the model. The anti-aliasing of the leaves could take
minutes or longer. In that case, you may want to have no or low anti-aliasing applied to the leaf material.
This will reduce the overall render time of the hundreds of leaves but still retain high anti-aliasing for the
rest of the model.

More about how to make great materials. Check out the collection of Render Ready Podium Materials
tutorials page
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Lights
1. Sky Light, Sun Light - Natural Lights

Click here to watch the natural light tutorial video

Also read information and tutorials on:

About Podium's Physical Sky
Preparing for Exterior Renderings
Interior lighting
Using SketchUp Styles instead of Physical Sky

SU Podium V2 has two types of natural lights. Sky and Sun. These are both "exterior" lights but can have great
influence on interior renderings if your models have openings to the exterior such as windows and doors.

Sky light is an ambient, exterior and uniform light source being emitted from the "sky". It is analogues to an
overcast day where the sunlight is hidden. Sky light is always on. However, if you have interior designs with no
openings to the exterior, sky light will be shut out.

Sky light brightness is controlled by a variety of variables. One is the preset you choose from the Preset list in the
Options menu. Another is whether you use SketchUp Sky or Podium's Physical Sky, also selected from the
Options menu in the Environment section. If you have selected SketchUp Sky, SketchUp's background colors will
control the sky light's brightness. If you have selected Podium's Sky or Physical Sky, SketchUp background colors
will be ignored. Rather the time of day will be an important factor in sky light color and brightness. Also the Sun/
Sky Brightness sliders in the Options menu will have some influence.

Sun light is another source of natural light. Sun light is only on when SketchUp Shadows are on. The sun's
brightness and exposure are controlled by a number of variables:

Presets from the Preset list in the Options menu
Sun intensity and exposure sliders
Time of day, time of year, location and position relative to North-South-East-West
SketchUp Sky or Physical Sky

But don't be intimidated by these variables. Take a look at the Options section and try some settings.

Helpful resources to understand Sun and Sky lighting
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Sun and Sky Video Tutorial
Introduction to SU Podium V2 UI - especially Part 2 video
About Podium's Physical Sky
Preparing for Exterior Renderings
Interior lighting
Using SketchUp Styles instead of Physical Sky

2. Artificial Lights - LEM, Omni's and spot lights.

Click here to watch the artificial light tutorial video.

Click Here to watch the spot lights and SU Podium Light System video

a. LEM Light

The Light slider in the material properties menu will apply LEM (Light Emitting Material) to the specific texture you
have selected. LEM lights are one type of artificial light source in SU Podium V2 and will create lights that emit
light in one direction away from the face of the texture. LEM lights are easy to create and are quick to render.
Light slider is the LEM light slider. Pick a texture and apply the light slider. This will turn that texture into a LEM
Light. You can pick a value from 1 to 100. The values must be whole numbers.

High Intensity check box is applied to the LEM Light. When High Intensity is on, single digit power values should
be used. Otherwise the LEM light will be extremely bright. In most cases, you will not need the High Intensity
option.

Note: Unlike Podium 1.X, V2 will apply Podium properties globally to textures. If you select a certain texture to
have light, every surface in the entire model with that texture applied will emit light.

b. Hidden LEM option

When Hidden LEM option is checked on, the LEM light will be rendered but the SketchUp face and material that
the LEM is applied to will not be rendered. This is a very useful feature if you want to hide the LEM light source
and keep the light. Below is a simple example.
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c. Omni Lights/ Point lights

Click here to watch the artificial light tutorial video.

Omni light or Point light (name is used interchangeably in this document) is an artificial light source which emits
light uniformly in all directions, similar to a light bulb. To insert an omni light or point light, click on the  icon in
the tool bar. This will invoke the Podium Light System dialog box.

There are some things to consider before creating an omni light.

Power. The light power value for omni lights ranges from 1 to 100. Because light power is relative the the amount
of ambient and natural light in the image and to the angle of your camera, you will need to experiment with power
levels.

Color. Color is self explanatory. Just as in the Light Properties menu, there is a color picker which allows you to
apply various colors to the spot light. Default color is white.

Placement. Once you have made Power and Color selection, click on Create. The omni lights have an intuitive
inference method of placement based on a temporary XYZ axis with green, red and blue lines coming out from the
center of the axis.

Beam Angles. This option is reserved for Spot Lights only.

Read more about the Podium Light System here.

d. Editing your omni light

It's easy to adjust light power and color for omni/ point lights. Select the the light point component in SketchUp.
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You can do this by picking the component (very small) or finding it in SketchUp's outliner. The point light will have
a name that starts as light-point. Once the light point component is selected, pick the light bulb icon from the SU
Podium V2 tool bar or menu. Adjust the light power from this dialog box. You can use decimal values for omni/
point lights. To change color, pick the Browse button from this dialog box and then pick the color you want from
the color user interface.

For LEMs lights, select the material with the SketchUp texture i-dropper and adjust the slider in the Podium
Material Properties dialog box. LEM lights only accept whole numbers. LEM light is a material property so different
from a omni/ point light.

e. Soft omni lights option

As a default, omni lights/ point lights have "hard" shadows meaning the edge of the shadow cast by the omni light
is hard. There is a soft shadow option that makes the omni lights look more natural. This option is accessed from
the Options menu in the Environment tab. There is a significant render speed cost when using this option.

soft omni shadows off, 2 min 18 sec at viewport rez soft omni shadows on, 4 min at viewport rez

3. Spot Lights

Podium Light System is both a spot light and omni lights (point lights) system. Spot lights are a type of omni light.
However, spot lights have one more option - beam angles. Please read about Spot Lights
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Render and Preview

Before rendering, you may want to check the Options menu, to see where the rendered image will be
saved and to look at other settings. As a default, the rendered image will be saved to the same folder
that your SketchUp model is in. However, the rendered image can be saved in a folder of your choice.
There is no browse button to find the folder of your choice. You must key in the address to save the
images.

To start the rendering process, click on the Render icon from the Tool bar..

Once the rendering process is invoked, you can preview the rendering progress by picking the
Preview menu in the Podium Render Manager UI (OOPR).
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Other Features in the pull down menu
1. Generate scripts

Generate has two useful purposes. Generate essentially is a manual way for Podium to create a .script
file that can then be run in the Podium Render Manager. This allows you to run the .script later if you
like. It also gives you an alternative, in case OOPR does not get initiated automatically during the
rendering process.

If you click Generate from the SU Podium V2 pull down menu, Podium will generate a .script file and
save it to a folder of your choice. Generate will render using your current Options settings. The
textures of the particular model will also be saved in the same folder as the .script file. You can later
Add the .script file to the Podium Render Manager enabling you to render scripts whenever you
choose. You can even stack scripts in the Podium Render Manager (OOPR) to render the scripts in
sequence.

To run .scripts inside SketchUp, open Podium Render Manager (OOPR) by choosing Podium Render
Manager from the SU Podium V2 pull down menu (you will need to install Version 2.8 or above). Then
use Add File. Then Start if the rendering does not automatically commence.

Alternatively, you can open OOPR from outside of SketchUp and Add the script file without invoking
the Render function.

Windows users - go to program files (x86)/ google/ google sketchup (7 or 8)/ plugins/
SU_Podium_V2/Programs/ and click on OOPR.exe.
Mac users - go to MacIntosh HD--Library--Applications Support--Google SketchUp (7 or 8)--
SketchUp--Plugins--SU Podium V2--Programs and click on OOPR.

Once you have the OOPR window open, click on Add File and add the .script file. Rendering will
commence when you do that.

Using Generate is also one way to trouble shoot a model that hiccups in Podium.

2. Tools

Tools is accessed from the SU Podium V2 pull down menu. There is no tool bar icon for Tools. Tools
is provided to help you analyse and reset the SketchUp model for Podium material and light
properties.

Analyse Model - this feature will Analyse the SketchUp model and return a dialog box which will
display information about Podium properties. The information includes: Podium V2 Light Sources and
Materials properties in the model. Analyse will list how many point lights, LEM and reflective faces are
in the model. It will also list the names of the materials that have Podium V2 properties on them. It will
also display any materials that have that have a combination of LEM and reflection properties on them.
Reflection and LEM properties on the same material will result in black rendered textures or crashes.
Furthermore, Tools now detects textures that are .psd and .pdf files which do not render.
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Analyse will not display properties that are created by Automatic Materials.

Reset Materials - Reset Materials will completely delete all Podium V2 material properties in the
current model. So, do not use this feature without first making a copy of your modeling and renaming
the copy. In some situations, it may be easier to Reset Materials for the whole model instead of finding
each individual material properties. Use this tool after you run Analyze. Reset Materials is irreversible.

Toggle Point Lights - This tool will turn off (and back on) all the point lights (omni lights) in your model.
As with Reset Materials, make a re-named copy of your model before using this tool.

3. Render Manager

Render Manager will invoke the OOPR user interface without you having to start a render process.
This is handy if you want to render scripts that you created using Generate.

4. About

About will display a web page that will show the SU Podium V2 version number that you are using.
There will be other pertinent information in this web page.
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More Features
1. SU Podium Browser with Light Fixtures, 2D and 3D Plants, Textures and Podium
materials

Podium Browser is part of SU Podium V2 and gives you access to hundreds of Podium V2 ready light
fixtures, alpha transparent plants and trees and SketchUp high resolution textures. Podium Browser
comes installed with SU Podium V2.4 and above. It also has a Paid section, which requires a
purchase of another license. This will give you access to thousands of more advanced light fixtures,
3D plants and Podium render ready materials. Click here for more detail on Podium Browser.

2. Omni Grid V2

Omni Grid is a plug-in for SU Podium V2 that allows you to create a grid of point lights ( omni lights)
above or below a planar surface (SketchUp face). By creating a grid of omni lights, Omni Grid creates
a relatively even source of light over a wide space. It is best for interior rendering. An alternative to
omni grid is LEM or Hidden LEM.

Omni Grid is a free plug-in. It does not come installed with SU Podium. You do need to install it
separately. As with all SketchUp plug-ins, close SketchUp completely (quit SketchUp in the Mac)
before installing. Make sure you install for the correct version of SketchUp. If installed correctly, when
you open SketchUp, OmniGridV2 is a accessed through SketchUp's context sensitive menu. Select a
face and right click.

A possibly better alternative to OmniGrid V2 is using LEM on a material. LEM lighting will give you a
very even source of interior lighting. OmniGrid V2 is a grid of point lights therefore the lighting will have
bright spots. Many V2 users that used OmniGrid in Podium 1.x, like OmniGrid and that is the primary
reason why it has been retained in V2. Please read about LEM material property in the LEM light
section here before using OmniGrid V2.

Click on download page for Omni Grid V2

Download page

Check the download page for free SU Podium plug-ins Download page

3. Podium::render

A function that will invoke Podium's rendering from a Ruby script or from the Ruby Console is included
in V2. The command is Podium::render( :filename => '' ) . Include the file name without extensions
between ' and ' if you want the script to render to a specific file name. Podium will append the file
name with 0000. If you want a unique file name do not use the ( :filename => '' ).

4. Render All Beta

Render All Scenes is a feature that allows you to render all the SketchUp scenes in a model in
sequence. When invoked, Render All, renders each scene and saves the image in the SU Podium
image save folder. This enables you to batch render several scenes in sequence or even create
photo-realistic animation especially if you have created the SketchUp scenes using SU Animate.
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Render All is still in beta for SU Podium V2. It is a Ruby Script that needs to be saved to your plugins
folder. Please download RenderAll from the Download page.

Read about Render All here
Download Render All from the Free Plug-ins page
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Tips and Tutorials
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This tutorial describes the very important Options setting, Presets.

Styles for SU Podium V2

Using SketchUp Styles is an alternative to using Physical Sky. SU Podium V2 now has Podium
Styles that get installed with Podium. Read about Styles here.

Hidden LEM tip- render a computer monitor or TV

How can you create the effect of a computer monitor or TV screen illuminating an interior space. You
can create this effect with the new hidden LEM.

This image was produced by Steven313 (Forum alias). Read about his discussion on how to do
this on this thread - Hidden LEM tip

Back to the Top of the Tutorial

How to get rid of blotches

SU Podium V2 presets are calibrated to be as fast as possible. Unfortunately, some
imperfections such as blotches or unexpected corner shadowing will sometimes appear in the
rendered image. These anomalies can appear quite randomly especially on non-texture pale
surface, corners and low polygon geometry scenes. Those imperfections are caused by the
lower quality and precision of the Podium V2 preset.

QMC presets are made especially to overcome this issue. But the cost is a substantially slower
rendering time. QMC presets can also produce a more grainy image. To overcome the
graininess of QMC presets, it is recommended that you render at a higher pixel resolution than
you need and re size the image after it is completed.

This will solve most of the current blotches and artifices. If they are still appearing with the QMC
presets, please contact us.
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Before with interior preset After with QMC-interior preset
Back to the Top of the Tutorial

Interior Lighting

Nicolas Harvey discusses tips on using Sunlight, LEMs and light fixtures for interior lighting.

Read about interior lighting tips here.

Back to the Top of the Tutorial

Getting ready to print

SU Podium's image "resolution" settings are based on pixel dimensions such as 800 X 600 or 1920 X 1080. Podium allows
for pixel dimensions that are greater than most video monitor sizes such as 4,076 X 3,304 pixels. You can even enter a
custom size such as 8,000 X 6,000. Why do we offer higher pixel dimensions than what most monitors provide? Primarily for
printing. The higher the pixel size image you have, the greater the paper size and document resolution you can print to.
When it comes time to print your image, there are some calculations to be made.

For example, if you want to print a rendered image of the size of 36" by 24" at 200 DPI (Inkjet), the pixel resolution in
Podium should be around 7200 X 4800.

SU Podium does NOT have any print capabilities. The JPG or PNG file generated by Podium will need to be printed from an
image editing program such as Photoshop, Fireworks, Paint Shop Pro, etc. The one feature you will need from your image
editor is the ability to change the print size dimensions and the Dots per Inch.

There are two terms often used in printing and that is PPI and DPI. They are often used interchangeably although technically
they have different meanings. The default resolution in Pixels Per Inch (PPI) for JPG/ PNG generated for a computer screen
is 72. Images on a monitor will look good at 72 PPI but if you print on most paper sizes at 72 PPI, the print will not look
good.
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Open a Podium generated PNG in Photoshop or Fireworks and look at the image size. If you opened a 1200 X 700 image
in Photoshop, you would see the document resolution is 72 Pixels/Inch and the default print size is 16.667 X 9.694 inches. If
you were to print at these dimensions, the resolution of the document would be poor. To get better print results, you need to
increase the document resolution by increasing the PPI or DPI. 

Turn Resample Image option off and increasing the PPI to 360. Now the document size is approximately 4 X 2 inches. That
means if you want to print an image that has a pixel size of 1200 X 700 on paper, the paper size would have to be about 4
X 2 inches if you print at 360 PPI.

Open an image in Photoshop (or your favorite image editor) that is 3076 X 2304 pixels. Turn Resample Image option off and
increase the Pixels/ Inch to 300. You can print this at 10.253 X 7.68 inches and at 300 PPI. As you can see, the higher the
pixel size of the Podium image, the more document size and print resolution options you have.

Printers use DPI measurements such as 300 DPI of Laser Jets or 200 DPI for Ink Jets. Although we often equate PPI to
DPI, DPI is a print term and is the number of dots of ink a printer can place per inch. Most often the printer's DPI is set to
some number like 200 or 300. The main thing to consider is the higher the document resolution measured in Pixels/Inch,
the better your print will look.

There is a related article here - http://photo.net/learn/resize/. Also, if you are confused about inch sizes and want to translate
to MM take a look at this paper size calculator web page - http://www.dpandi.com/paper/index.html. Another useful image
size/ paper size calculator web page is here - http://auctionrepair.com/pixels.html.

Back to the Top of the Tutorial

Podium Materials - Why Diffuse, Transparency & Reflection?

When you start to set up your own materials, you will start in SketchUp by applying texture, color and transparency.
SketchUp allows you to configure and display these basic material properties.

Podium supports some more complex and subtle properties like reflection, refraction, bumpiness and light emission. These
are very straightforward to set up. But there are some things that it are helpful to understand first of all.

There are three main sliders in the dialog labelled - Diffuse, Transparency and Reflection. These configure the basic surface
properties, and this article explains them in a little more detail.

In reality, the way you perceive a material is based on the way rays of light (the technical term is ‘photons’) hit the surface,
reflect off it and travel to your eye. Light is actually invisible until it hits something. If you shine a flash light in a cave, the
only light you will see is reflected off surfaces. You will see a patch of light where the it hits a surface, but if there is no dust
or water vapor, you will not see a beam of light like a laser. Where you can see a distinct ‘beam’ of light, this is caused by
light reflecting off particles in the air. This illustrates the basic principle that our ability to see objects is entirely based on the
principle of reflected light.

When light hits a surface, some of the energy is absorbed, and some reflected. Diffuse reflection is what enables us to
perceive color and texture, and describes the way that when light hits an object, it penetrates just below the surface of a
material and is reflected, but the light is ‘diffused’ or scattered in different directions. Even highly polished surfaces have
diffuse reflection. For example, a polished white marble surface is still identifiably white. When light hits a surface, the color
the surface appears depends on the wavelengths of light absorbed and reflected by the surface. For example if a surface
absorbs more light in the red spectrum, then that surface will not exhibit much red in the color If the surface reflects more
light in the red wavelength, its color will appear to be reddish. This is a complex topic in its own right (more info here) but it
demonstrates that you almost always need some diffuse reflection for any surface. Even for colored glass, if you want to see
the color, you need an element of diffuse reflection.
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What people usually understand by the term ‘reflection’ is technically ‘specular reflection’ and it occurs when light bounces
off flat surfaces and is reflected in a uniform direction. This is easy to understand, and as you increase the value of this
slider, the more your material will reflect the environment.

The third component is transparency, which is when light passes through a surface.

A material’s appearance is based on the way light interacts with the surface. Some of the light is absorbed some passes
through it, some is reflected back and diffused, and some is reflected back in a uniform direction.

Podium’s way of rendering materials is based on these physical properties. So if you want to get the most realistic materials,
you need to be aware of the need for the diffuse component, and balance this against reflectivity and transparency.

In Podium, because almost all materials absorb some of the light that hits them, materials are configured so that if the sum
of the diffuse, transparency and reflectivity sliders adds up to 100% in the dialog, the actual total used by the render engine
is around 95%. It is also impossible to configure the sliders so they add up to more than 100% which would be unrealistic
because it would mean that materials reflect more light than they receive!

For most materials, the most realistic appearance is obtained when the sum of the values in all three sliders adds up to
around 100%. It does not’t matter if it’s 97% or 98%, and some solid, non-reflective surfaces (like wood for example) may
absorb more than 5% of the light energy that hits them, so configuring them by setting the diffuse slider to 80% should’t be a
problem.

In summary, when configuring materials, understand the diffuse component, and set some value for it for virtually all
surfaces.

Back to the Top of the Tutorial

Preparing for Exterior Renderings

The first step to setup any Podium rendering is to choose which preset to use. There are three categories of presets; default,
exterior and interior. Default is a general purpose preset not calibrated for anything specific. On the other hand the two
others presets are especially made to give the best results for their specific environment. In addition, these two presets have
several variation to give different quality and speed results which are preview (lowest quality but fastest), QMC (highest
quality) and the standard.

Although, it is recommended to use the QMC preset, when you notice imperfections, blotches or blemishes, 1.0_exterior.pps
is often sufficient. Default.pps preset is not adequately calibrated for exteriors scenes and results in unbalanced rendering
such as too bright or too dark. 1.0_exterior.pps is generally the best choice for your exterior scenes. (Exterior scene would
be defined as a environment that uses either sun light or sky light or both as predominant light source.)
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After you have selected your preset, you can adjust sky and sun light. Do not forget to activate shadows in SketchUp for
Podium to use Physical Sky and use its own sun orientation. Podium physical sky is the key for realistic renders. This will
give a greater color depth than the SketchUp sky. Make sure it is activated in the “Environment” tab of the Podium Option
window. It is also in this window that you will able to adjust the Sun strength. You can modify brightness with the intensity
and exposure sliders.

Intensity controls the brightness of areas that are exposed to sunlight. Exposure will control brightness of shaded areas. If
you want to simply adjust the sun’s strength, move the two sliders equally. Be generous because less than 25% changes
will not have an effect.

Sun Intensity/Exposure at 0%

Sun Intensity/Exposure at 100%
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You are now ready to do some test renderings, add advanced material properties and some detailing to get the best
rendered image.

Back to the Top of the Tutorial

Using PP to finalise your rendering

If you did not already know, the acronym “PP” which is vastly used in the rendering world refers to Post Processing. It is a
“second touch” to your images produced by the renderer. Many programs will help you do this. The most popular,
Photoshop, will be used in this article, but many other lower cost or free image editor exist. Some examples would be Paint
Shop Pro, Fireworks, Gimp and even Adobe Elements.

The goal of PP, is to fine tune your images; tweaking it to your liking, with speed and a lot of control. Using PP is a lot faster
then re-rendering in Podium each time you need a tweak and therefore is very productive. Many PP features are not offered
in Podium simply because they are readily available in PP programs. Post processing programs are especially good at
tweaking colors, brightness, contrast, etc. so lets leave these features to them. In addition, all photography and rendering
professionals uses PP. Post processing is often a necessary part of your work flow as you can not expect even the most
advanced photo-realistic rendering program to output perfect images every-time.

Good lightning is crucial for a high quality image and can be tricky to achieve directly in Podium. That’s where PP comes to
help. There's no need to fine tune your lightning in Podium/ SketchUp. One achievable goal is to get all the correct light
sources to provide an acceptable level of brightness in Podium. Then, adjust the lighting to your taste in PP. For example, a
dark rendering is easy to brighten-up whereas an image that is too bright will often be beyond repair. So it is better to aim
for less brightness in Podium to be tweaked in PP, where you have instant response and lots of control.

In Post Processing programs, the brightness feature generally will not give you good results as it will whiten or darken the
entire image. What we want to do instead is to brighten the white areas, almost as if the Podium lightning was stronger.
That’s where the “Levels” tool in Photoshop ( CRTL+L) is very helpful. Move the right slider to the left to brighten your
image, but do not overdo it, so as not to lose information. Moving the left slider a bit to the right will also add some depth.

When the graphic shows low values on the sides, the sliders can generally be moved towards the middle without losing too
much information. This is often when they need to be moved.
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Below - Before: Raw Podium render - almost too dark to be usable.

Below - After Post-Processing: Levels adjusted to brighten up. Color balance to match the out-door photo and photo
integration.

Below - Example of an over-lit rendering that cannot be saved
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Many other modifications can be made, to make your renderings look better, such as; color balance (reducing the blue tint)
saturation, depth of field, god rays etc. All of these, and many more have extensive tutorials on the Internet.

You many wonder why SU Walk, includes a brightness slider and Podium does not. The reason, beside all the others
mentioned above, is pretty simple. Walk is a real-time application used for video animations. When you change the value,
you see the result immediately. That would not be the case for Podium. It would cost a lot of develop time to have PP
features in Podium that are readily available in lots of image editing software.

PP techniques will save you a lot of time and help make your renderings look great with some practice. Head over to the
Podium forum to get insight from us and other members on how to make your rendered images look better or show the rest
of us your skills and techniques.

Happy rendering,
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Tip - Lighting up your interior models with SU Podium V2 by Nicolas Harvey, tech support

Sunlight produces the most realistic and fastest rendered images. This should be the main way to light up your day time interior
scenes. Try to get as many openings to sunlight as you can and orient the sun so that the light enters adequately, if possible. For
example, remove a wall that is not visible in the scene can get you more sun light. If you are using sunlight, do not forget to adjust
the Sun intensity/Exposure Sliders found in the Environment tab of the Podium option window. (Make sure Physical Sky is on)
These sliders still apply to interiors. Setting the sliders to the max is often a good thing to do when you do not have big openings.
This techniques is easy and fast to set up and render. In many cases sunlight will provide enough interior light, therefore it is
recommended to try sunlight first for interior renderings.

Without sunlight example:

 
Click on image to see full size

With sunlight, Physical Sky, Sun Intensity/Exposure 30%

 
Click on image to see full size

If sunlight alone does not produce adequate lightning, you can use large LEM material behind the SketchUp camera, to give an
even light spread. This is a lot faster to setup, tweak and render then adding multiple point lights. You can also replace windows
with LEM material to give an extra light boost. On the down side, LEMs produce noise when they are too strong so do not use the
high intensity option. Make the LEM material bigger with less power. Contrary to V1, Podium V2 renders LEM faster than omni's.
This is why it is an excellent way to light up interiors.

LEM behind the camera
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Click on image to see full size

Resulting render with LEMs at the windows and a few light fixtures. Rendered with Interior QMC 1.0, size reduced 3 times.

 
Click on image to see full size

Finally, let's not forget about the Podium Browsers' light fixtures. Even if you are rendering a day scene, you probably still want to
have light fixtures in your interior design. You can turn them "off" by using the dynamic component options.

If you are doing a night scene, you can insert the Browser's light fixtures to create most of your lightning. The light fixtures are all
calibrated to be realistic. Just as one or two 60 watt fixtures in a room is not enough lighting for a good photo, one or two Podium
light fixtures in a interior design is probably not enough for a good rendering. Use an adequate number of light fixtures in an interior
space to provide good lighting.

Supplementing light fixtures by adding an LEM material behind the camera is also an option but a few point lights in mid-air is
often effective in night renders. I would suggest that you use as few point lights as possible because the more you have, the more
unrealistic the image will look. Instead of stand alone point lights, try to use realistic light fixtures. For example, recessed ceiling
spots are particularly useful.
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Tip - Preparing for Exterior Renderings with SU Podium V2 by Nicolas Harvey, tech support

The first step to setup any Podium rendering is to choose which preset to use. There are three categories of presets; default,
exterior and interior. Default is a general purpose preset not calibrated for anything specific. On the other hand the two
others presets are especially made to give the best results for their specific environment. In addition, these two presets have
several variation to give different quality and speed results which are preview (lowest quality but fastest), QMC (highest
quality) and the standard.

Although, it is recommended to use the QMC preset, when you notice imperfections, blotches or blemishes,
1.0.5_exterior_default.pps is often sufficient. Default.pps preset is not adequately calibrated for exteriors scenes and results
in unbalanced rendering such as too bright or too dark. 1.0.5_exterior_default.pps is generally the best choice for your
exterior scenes. (Exterior scene would be defined as a environment outside of a structure and uses either sun light or sky
light or both as predominant light source.)

After you have selected your preset, you can adjust sky and sun light. Do not forget to activate shadows in SketchUp for
Podium to use Physical Sky and use its own sun orientation. Podium physical sky is the key for realistic renders. This will
give a greater color depth than the SketchUp sky. Make sure it is activated in the “Environment” tab of the Podium Option
window. It is also in this window that you will able to adjust the Sun strength. You can modify brightness with the intensity
and exposure sliders.
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Intensity controls the brightness of areas that are exposed to sunlight. Exposure will control brightness of shaded areas. If
you want to simply adjust the sun’s strength, move the two sliders equally. Be generous because less than 25% changes
will not have an effect.

Sun Intensity/Exposure at 0%

Sun Intensity/Exposure at 100%

You are now ready to do some test renderings, add advanced material properties and some detailing to get the best
rendered image.
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Preset Page
The SU Podium V2 presets have been crafted for certain rendering environments and are available
from the Options menu in SU Podium V2. Presets were created to control hidden variables that effect
things like Physical Sky turbidity, sun brightness and contrast, ray trace bounces, amount of ambient
light, tone mapping variables, anti-aliasing, etc.

There are three categories of presets; default, exterior and interior. Default is a general purpose preset
not calibrated for anything specific. Interior and exterior s presets types are especially made to give the
best results for their specific interior or exterior SketchUp environments. These two presets types have
several variation to give different quality and speed results. Specifically _preview is the lowest quality
but fastest, standard, high and QMC (highest quality). Use the _standard preset if you have any
questions. If you have a combination exterior and interior scene, you may need to experiment with the
best preset.

The presets stored in the Preset folder in the SU Podium V2 folder.

Note - when you install a new version of SU Podium V2, the preset folder is not replaced. Existing
presets from previous versions will remain in the preset folder. If you want to decrease the number of
presets, go to the SU_Podium_V2-->Preset folder and delete presets you no longer want. Optionally,
uninstall SU Podium and then reinstall. (Mac users - you will need to Move to Trash to uninstall. Check
the Help/ Install section.)

Presets can be opened and edited with a text editor if you know what you are doing. If you want to
venture into creating your own presets, please read the PDF document that describes all the Podium
rendering hidden variables at the bottom of this page.

This page offers non-standard presets that Cadalog, Inc. and other customers have developed as an
alternative to the presets that come installed in SU Podium V2. Download these .pps files to your:

c:\program files (x86)\google\google sketchup 8\plugins\SU_Podium_V2\presets\

or for Mac users - MacIntosh HD\Library\Application Support\Google SketchUp
8\SketchUp\Plugins\SU_Podium_V2\presets\

Non Standard SU Podium V2 presets:

Important Note: Presets have a file extension of .pps which your browser may mistake as a Power
Point file. Right click on the Download here link and use Save Link As...

1.0.3 Exterior 
This is a good exterior preset to give you more
control of sun intensity and exposure sliders. Download here

1.0 Exterior Night
Obviously created for night exteriors Download here
1.0.5_interior_default_no AA
There is a zip file with a .pps file in it and jus the .pps
file.
This interior preset has no anti-aliasing (resampling)
and will result in very quick rendering that only has
raytracing and GI.

Download Here 

Download the Zipped
version
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Check the SU Podium User forum in the Preset thread for continued customized presets and
discussion. Click Here for the Preset Thread in the Forum.
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Transparent Background option
Important feature of SU Podium V2 is the Transparent background option. With the PNG format on,
Transparent will create rendered images that have alpha transparent backgrounds. This will allow you to
easily add your own background image to the rendered .png file using an image editor program.

The following is an example of using Transparent in the Options menu.

1. Choose the Transparent option in the SU Podium V2 Options menu. Make sure the Output format
for the rendered image is PNG.

2. Open the saved .png rendered image in an image editor such as Photoshop or Fireworks. As you
can see the background is automatically saved as an alpha transparent background.

3. Open your own background image in your image editor and copy it.
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4. Insert or cut and paste your own background image into the rendered .png file. Arrange or move
your background image backward or to the back.

Click on image to view a larger resolution
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Click Here for the Video Tutorial: Introduction to Environment Tab - Sky, Sun sliders, Soft Omni, Clay

Environment Settings Table of Contents - The Environment tab gives you access to Podium's global settings

a. Background Default
b. Physical Sky
c. Sun intensity and exposure sliders
d. Soft omni lights
e. Caustic
f. Clay
g. Geometry Caching
h. Information Bar
i. Translucent color
j. Automatic Materials

a. Default Back to Environment Settings TOC

Default will use your current SketchUp background color and/or SketchUp Sky settings (set in your SketchUp Style) for the
rendered image's background colors. A related subject is Podium Styles.

b. Sky or Physical Sky. Back to Environment Settings TOC

Physical Sky is a setting where Podium calculates and displays Sky turbidity (haziness caused by particles suspended in the
atmosphere) and depth. Physical Sky will ignore the SketchUp background colors but rather is controlled by the preset
variables, time day and year, location. Physical Sky will only be on when SketchUp Shadows are on.

Physical Sky option. SU Podium's physical sky creates an accurate simulation of the real sky. It produces a realistic
background with a greater color depth than SketchUp’s default background. Therefore, Physical Sky is almost always
the best option. However, like in the real world, midday sky casts a bluish tint. In the real world, we don’t notice the
blue tint (on a sunny day) because our eyes accommodate for the colors. If you are inside an artificially lightened
building around noon on a sunny day and go outside, you will immediately notice this blue tint. But after a while, the
tint will disappear. There is a specific color to every time of the day. For example, morning and evening will be yellow
and noon will be white/blue.

Physical Sky has a sky color gradient that you can not control. The color will depend on the time of the day and year
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that your SketchUp shadows are set to. If you don’t like this effect and/ or want to have control of the sky color as
well as additional control of sun light, do the following:

SketchUp sky option. There are situations that you do not want the physically accurate sky simulation. You may want
to do a night rendering or need others atmospheres or you may find the physical sky is too bright and want to control
background light with SketchUp colors.

Turn off Physical Sky in the SU Podium Options/Environment dialog.
Go to SketchUp Styles and then to Background. Darken the color of your background. You can also turn off or
on SketchUp's Sky.
If your SketchUp Shadows are on, change the time of day of month so the sun is at a different angle.

SketchUp Styles. In some cases, you may want to turn off Physical Sky and use your own SketchUp styles. We have
made some SketchUp styles to help you. These styles are simply modified SketchUp sky and background colors. You
can download the styles from the Styles page on www.suplugins.com.

Note: When your SketchUp shadows are on, Sun light is on regardless of what background option has been selected.

c. Sun Intensity and Exposure sliders Back to Environment Settings TOC
Sun intensity and exposure sliders in the Environment settings. Move sliders to the left and the rendered images will
have less Sun exposure or intensity. The opposite effect will be true if you move the sliders to the right. Rest will
reset the slide values to the original state.

d. Soft omni lights Back to Environment Settings TOC

is a global setting for omni or point lights. The default setting is for this option to be checked off. However, if you want soft
shadows to be applied to omni lights to create a natural lighting effect, turn this on. Soft Omni Lights is discussed in more
detail in Light Section.

e. Caustic Back to Environment Settings TOC

will apply a caustic effect to transparent materials, globally.

f. f. Clay Back to Environment Settings TOC

is where textures are ignored and the entire model is rendered in the default, front face color of SketchUp - like a clay
model.

g. Geometry Caching. Back to Environment Settings TOC
The SketchUp geometry can be cached to increase rendering speed. SU Podium's first step in creating a photo-
realistic image with raytracing and GI, is exporting the SketchUp model information to it's rendering engine. This is
called Process Scene. Model information includes SketchUp geometry (faces and groups) , textures, shadow, location
info, etc. Geometry caching will cache the geometry/ texture data and reuse it on subsequent rendering if there are no
modifications done to the geometry and textures. This means when rendering a model multiple times, SU Podium will
skip the Scene Processing step and reduce rendering time when the geometry and texture data have not changed.
Geometry Caching can save you a lot of time when you are simply changing light or camera views between
renderings. For example, if you are simply changing SketchUp scenes or shadow positions or Podium light values,
Geometry Caching has the potential to save you a lot of time.
However, SU Podium will not use caching if faces, groups, textures and other geometric entities have been modified
between renderings. There are potentially some cases where geometry caching may have adverse effects and
therefore you have the option to turn this off. Geometry caching will not work with face-me components. SU Podium
will re-render models from scratch if there is any face-me components in the model.

 h. Information bar. Back to Environment Settings TOC

If this option is turned on, the rendered image will display an information bar at the bottom of the image. The information will
contain the Podium version, rendering engine version number, preset used, time to render and the pixel size of the image.
This is useful information to have when you contact Cadalog for support or share information on the Forum.

i. Translucent color (colour). Back to Environment Settings TOC

SU Podium Version 2 now supports color in reflections of light passing through colored translucent material. (You will need
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SU Podium V2.8 or above). This is most apparent in material that only has color but not textures. For example, the below
example if of transparent material that only has colors. If these materials had texture images in them, the color reflection
would not render. Future versions should have support for colored textures and colors in shadows.

In SU Podium before V2.8 Same model with SU Podium V2.8 +

To turn on support for color in translucent material, go to the SU Podium V2 options dialog and choose Environment. Turn
on the Translucent Color check box. By default it is turned off.

j. Automatic Materials Back to Environment Settings TOC

SU Podium Version 2.9 and above has a feature called Automatic Materials. When this is on (default), Podium will
recognize SketchUp standard material names in your model and assign pre-defined, photo-realistic material properties to
these specific SketchUp materials, automatically. This will greatly reduce the amount of time you may spend setting up your
model for photo-realistic renderings, IF you are using SketchUp standard materials. Automatic Materials will have no effect
on imported textures/ materials. Please read or watch the video regarding Automatic Materials here.
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Render Ready Podium Materials tutorials
1.Chrome
2. Plastic
3. Translucent Glass
4. Bumps

Chrome

We will start with chrome, one of the easiest materials to configure. First of all create a new
material with a black or very dark grey base color and apply this to your surface(s). Call this
chrome.

Open the Podium material editor, then with SketchUp’s eyedropper (ctrl click the paint bucket)
select the surface with the new material. In the Podium materials editor, you should see the
material name displayed if you have selected it correctly. Set the diffuse slider to a low value ,
around 5% should be fine, and then move the reflection slider to make up the difference to 100%.

Note that Reflection is not set at 100%. This is because in reality, there is no such thing as a
perfect mirror. The Diffuse component is what enables us to see the color of an object. It will work
if you set reflection to 100%, but it is helpful to understand how surfaces behave in real life.
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Back to the Top of the Tutorial

Plastic

When you look at most types of plastic, you will see that it is generally glossy. This is because the
surface is fairly smooth and flat. However, unlike other smooth, flat surfaces, like wood or painted
plaster, it does not have a completely matt finish. We will cover wood and painted walls another
time.

In reality all materials reflect light, this is the diffuse component that you see in the materials
dialog, and it determines our ability to see color. In Podium, if you want to make a surface shiny
or glossy, you will need to move the reflection slider. For a glossy rather than shiny effect, you
need to make sure the Blur box is checked.

Note that when you use blurred reflection, the blur tends to have the effect of reducing the
reflectivity, so you may need to increase the reflectivity more than you would expect.

There are a number of different types of plastic, most of which tend to be glossy in varying
degrees. Very shiny plastic is easy enough to simulate. Simply use the reflectivity slider. You
should not need a value greater than 10, even values of 2 or 3 will produce a noticeable sheen
depending upon the angle at which light hits it. The cube below simply has diffuse 98%,
Transparency 0%, reflectivity 2%.

Slightly glossy plastic is a little more involved, but still straightforward. If you increase reflectivity
to 20%, you will get a result like that below.
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Be careful of setting reflectivity too high. It is not just a case of increasing reflectivity. The more
your surface reflects the environment, the less prominent its color will be, because the surface is
reflecting the environment. The image below shows what happens when you set reflectivity to
50%.

Notice that the glossiness is similar, but the color has changed as the cube is reflecting more of
the sky. For an interior scene, the effect would be quite different as there are lots of other colours
and the overall lighting level is likely to be lower. Do not be afraid to experiment, because
depending on the conditions, you will need to adjust the settings to get the precise effect you
want.

You will also notice a slight graininess to the blur. This is hard coded into the presets. The
smoother the blur on the reflection, the longer it takes to render. The current setting is a good
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compromise between speed and quality. Blurred reflections will increase render time. From a
distance, the graininess of the blur is not noticeable.

Many types of plastic, for example those used on a lot of computer equipment, is slightly textured.
If you look at the archetypal computer case, keyboard, laptop power supply etc. you will notice a
kind of glossy, textured surface. This is also not difficult to simulate in Podium. The image below
shows the effects you can achieve. It takes a little more work, but it is not too complicated. For
this, you will need am image editor. In Photoshop I used a simple noise filter which just created a
random series of tiny dots, slightly darker than the main body color. The raw texture is shown
below.

It still looks predominantly like a plain color but you can see the speckles. Use this instead of a
plain color in SketchUp. The advantage of the texture with spots, is that Podium can use it to
create a bump map. This is an effect which simulates a bumpy surface. Most render engines
require you to load a separate bump map. This is usually a high contrast monochrome version of
the actual texture. The render engine will analyse the dark areas in the bump map image and
use this to simulate the effect of depth in the corresponding areas of the actual image texture.

Podium creates temporary bump maps during the render process, so you do not need to use
separate images. This is not as flexible as using separate bumpmap images, but it is a lot quicker
and easier to set up. The image below has material settings of D80/T0/R20 with a bump value of
8.
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You can see the effect of the bump setting towards the lower half of the cube. A magnified
section of this is shown below.

This orange peel effect is characteristic of textured glossy plastic. Notice that you ca not really
see the speckles on the texture, because they have been transformed into a bumpy effect on the
surface.Blurred reflection is the more common than the mirror (or environment) reflection you see
in glass, water and chrome.

Using this adds a lot more realism to your scenes. Once you look around at your environment
with a view to simulating it in a render, you will see blurred reflection on painted walls (satin effect
paint for example), sealed wooden floors, and brushed metal. It is worth remembering that the
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effect needs to be used carefully and selectively, so as not to increase render time too much.

When you want to render a material, it is always best to try to look at it critically and understand
its properties, then you will be able to simulate it more realistically.

Back to the Top of the Tutorial

Translucent Glass

Translucency is the property where a material allows light to pass through it, but does not allow
you to see any detail. You can see outlines where light is blocked from travelling though the
surface, but little more than that.

What is happening here is that light entering the material and passing through it is being
scattered, preventing any detail from being seen. 

In some render engines, this can be tricky to configure. In Podium however, you just choose an
index of refraction for your material, and check the 'blur' box. Just as with blurred reflections,
there is nothing else to configure.

The image below shows the effects you get with D5/T95/R0 and refraction set as ‘glass’. I have
used the new materials configuration scene here and you can clearly see the white outline of the
base plane behind the cube. 
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As you can see, this is quick, easy and realistic. We can get different effects by playing around
adding reflection, blurred reflection, and textures.

The image below uses a texture map with a fine grain (Photoshop 256x256, mid grey,
>Filter>Texture>Grain) to create a slight bump effect, similar to what you find with sand blasted
or acid etched glass. 

You see the sandblasted effect on the enlarged area below, along with the texture used to
achieve it.
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You can also get slightly different effects by altering the index of refraction. The image below
uses IOR of 1.1.
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We can get more varied and subtle results using reflection as well, as you can see from the
results below. In these images, Podium’s physical sky has been turned on to show the
differences more clearly, which aren’t as evident with a plain grey background.
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One important thing to note is that blurred refraction will increase render time, sometimes
substantially, depending on the scene. If you have a complex scene it is best to test render speed
before applying this property.

If you have purchased the additional paid library, there are a few pre-configured examples of
more complex glass for you to experiment with. 

If you haven’t seen this yet, first of all you will need to update your version of Podium. The
‘Materials’  differ from ‘Textures’ in that are fully configured with texture scale, reflection,
refraction, bump etc all preconfigured. When you click on one of these items, it inserts a 1m x 1m
cube into your model. Use the Materials eyedropper to apply these to surfaces in your model.

Back to the Top of the Tutorial

Basics of Bump mapping

First, a little background.

Bump mapping and its variant ‘Normal mapping’ are techniques used by render engines to
simulate bumpiness on a surface. Put simply, bump mapping is a 2d representation of a 3d
surface, normal mapping is a more complex and accurate technique using greater colour depth to
provide additional information about the 3 dimensional properties of a surface. Podium doesn’t
support normal mapping at the moment, it is included only for the sake of completeness.
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In simple terms bump mapping works by analysing a surface to determine the high and low
points. Logically, the low points are the dark areas, and the high points are the lighter areas. The
rendering algorithm then calculates the ‘surface normals’ which are points perpendicular to the
plane the texture is on. Based on the angle of the normal relative to the camera, and the
brightness of each point, the render engine adjusts the pixel brightness of each point on the
surface to simulate how light would reflect off it, simulating actual bumpiness.

There are two ways that this bump mapping is implemented, either using the brightness values of
the coloured pixels, or using a separate bump map. Most high end render engines require
creation and use of individual bump maps, specific to each texture. Typically these are
monochrome versions of the texture file that have to be loaded into the render engine for each
texture. The contrast and exposure values determine the accuracy of the effect. There are some
tools like CrazyBump which give a lot of control over the effects, but for most people (i.e. the non-
professional render artist or designer), you won’t notice the effects of the subtlety that tools like
this offer. You can waste a lot of time playing around for little discernable difference in your
render. In keeping with Podium’s ethos of simplicity and productivity, the render engine creates
its own bump maps on the fly. All you need to do is move the slider.

Examples of bump and normal maps are shown with the main texture map below.

Normal and Bump map versions either side of the diffuse texture.

When used properly, bump maps add realism to renders. They are best used for textures that are
close to the camera, for surfaces that have clearly-defined dark and light areas.

The image below shows a textured surface without bump mapping. It has blurred reflection
applied to give it a slight sheen.
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The image below shows the benefit of bump mapping. I have used a value of 20, which is quite
high. You can see more detail, and the raised areas look more realistic.
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Bump mapping can be particularly effective when used with blurred reflection.

For surfaces like masonry brick and blockwork, you can also get a better sense of surface
roughness. The image below shows the difference. What is noticeable is that the effect is not as
pronounced as you might expect. This is because it depends on the amount of contrast in the
main texture, and it’s resolution. The better your initial texture, the more noticeable the effect will
be.
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One of the best uses of bump mapping is for creating water using a flat plane.

Used with reflection and refraction, this can be remarkably effective, while keeping the polygon
count down.

The Podium Browser has a fully  configured water material in the ‘free’ section. It is configured as
D5/T57/R38 with the refractive index set as water, or 1.33. Bump value is set at 5. You can
increase this, depending on the texture map you use, but be careful of setting it too high, or you
will get a ‘cast glass’ effect instead.

The above settings generally produce pretty good results as you can see from the image below.
Setting the diffuse value at 5 just gives a slight colour tint to the water. Getting the balance
between reflection and transparency can be tricky, and may need to be modified depending on
the materials below the surface of the water, the angle of the sun and the texture used for the
water.
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Sometimes however, it is better not to use bump mapping at all. Although it is fairly quick, there is
a definite speed penalty when it is used. Also, when viewed from a distance, bump mapping
sometimes has unhelpful results.

The first scene below uses no bump mapping. Note the render time.
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Okay, let’s do something about that wall and add some bump. We’ll start with a modest value of
8.
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You can see a subtle bump effect on the right hand wall. You can’t see the effect as clearly on
the other walls, because they are in full sun and there isn’t a lot of contrast in the original texture,
which means that it isn’t that bumpy. So far so good, and render time seems to have decreased
slightly. This is quite normal given what other processes may or may not be running in the
background.

Let’s try and increase the bumpiness to 30 and see what that does.
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Here you can see that the high bump value makes the wall look ‘grainy’. Not too realistic!

This is quite common as you can see in the following image.
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You can clearly see the graininess on the floor plane caused by bump mapping. The thing to
remember is that just because you can do something, doesn’t mean you should!

In summary, Podium’s bump mapping is really easy to apply, and can create some nice subtle
effects. However, it needs to be used with care, and the values used depend on the lighting,
texture scale, viewing angle and distance of the surface to the camera.

Future releases of Podium will allow loading individual bump maps for greater control over the
results. For the moment though the process is automated. It is quick and easy to apply, but the
trade off is lack of flexibility.
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SU Podium SketchUp Styles
SU Podium V2 has a feature called physical sky which can be access from the Options menu. There's
often a question of when to apply physical sky or to use SketchUp’s default background. Here’s some
tips and explanations on this topic.

SU Podium physical sky creates an accurate simulation of the real sky. It produces a realistic
background with a greater color depth than SketchUp’s default background. Therefore, Physical Sky is
almost always the best option. However, like in the real world, midday sky casts a bluish tint. In the real
world, we don’t notice the blue tint (on a sunny day) because our eyes accommodate for the colors. If
you are inside an artificially lightened building around noon on a sunny day and go outside, you will
immediately notice this blue tint. But after a while, the tint will disappear. There is a specific color to
every time of the day. For example, morning and evening will be yellow and noon will be white/blue.

Using a night style for night time colors.

There are situations when rendering that you do not want the physically accurate sky simulation. You
may want to do a night rendering or need others atmospheres. In these cases, SketchUp’s style can
help. A fast color adjustment in a Post Processing program like Photoshop is also very effective. We
have made some SketchUp styles to help you. These styles are simply modified SketchUp sky and
background colors. These are now available in the SketchUp Style dialog box. They are automatically
installed when you install SU Podium V2.10 or above.
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Podium Light System for omni and spot lights

 
Click on image to view an HD YouTube video

Podium Light System V2 (PLS) includes the spot light feature for SU Podium V2 as well as the method of inserting and
editing omni lights (also referred to as point lights). PLS has a logical user interface and has an inferencing/ snap method
that allows inserting spot lights and omni lights simple.

Click here to watch the artificial light tutorial video

 PLS is accessed from the SU Podium V2 tool bar or from the SketchUp Plug-ins menu.

Upon picking the Podium Light System Panel icon, the PLS user interface will be displayed. To create a spot light, pick the
Spot button. To create an omni light, pick the Omni button. Clicking on the Create button will invoke the placement process
of either the spot or omni light. However, before clicking on the Create button, examine the options such as Power and
Color. For spot lights, you should also consider the Beam Angle options.

Spot Lights

There are several things to consider before creating a spot light.
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Power. The light power value for spot lights ranges from 1 to 100. A spot light power of 1 will be quite dim. Because
light power is relative the the amount of ambient and natural light in the image and to the angle of your camera, you
will need to experiment with power levels.

Color. Color is self explanatory. Just as in the Light Properties menu, there is a color picker which allows you to
apply various colors to the spot light. Default color is white.

Beam Angle. The spot light emits a cone shape light on the face you select. The beam angle inner cone controls the
size or diameter of the spot light referred to as the inner cone. The outer cone is the diameter of the spot light's drop
off area or soft shadow area . If you want the spot light to have hard edges, make the outer cone diameter equal to
or less than the inner cone. If you want the spot light to have a soft shadow area outside of the spot light (or light
drop off area) make the outer cone diameter greater than the inner cone.

Placement. Once you have made Power, Color and Beam Angle selection, click on Create. The spot lights have an
intuitive inferencing method of placement based on a temporary XYZ axis with green, red and blue lines coming out
from the center of the axis.

First click. The red square represents the center of the XYZ axis. Your first click will be to place the red square
on an entity in your model. Think of this as your first inference point. Once you do this you will see a 3D cross
hair and an XYZ axis display. You can move the 3D cross hair anywhere in 3D space but if you move the
cross hair along one of the axis lines, it will snap to the axis line. Use your Shift to keep the cross hair fixed
on the axis line.
Second click. Your second click will be your where the light source will be located. When you make the second
click, you will notice the axis will move to this point.
Beam Angle. Next drag the beam angle line to a location on a face and click. This will be the center point of
the spot light.

Now you are ready to render your spot light.

Omni Lights

PLS Omni light button will create omni or point lights. When you choose the Omni button, your options will be limited
to Power and Color. There is no beam angle for omni lights.

When you click create, you will get similar inference snapping as Spot Lights. However, you will not be able to choose
a beam angle.

Editing

You can edit spot lights or omni (point) lights after they have been inserted. Just click on the spot or omni light. and open
the Podium Light System user interface. You will notice the same values as were originally applied to that particular light,
will appear in the dialog box. For omni lights, you can change the power value and color. Power value can be a decimal. For
spot lights, you can change power value, color, inner cone and outer cone size. However, you can not change the actual
angle of the spot light, light source. You can also use SketchUp's Outliner to select the omni or spot light. The omni light is a
group called <light-point>. The spot light will be listed as a <light-spot> group.
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Render All V2 Beta

Render All Beta for Podium V2 has a dialog that allows you to choose the scenes to be rendered
and highlight which scenes you want to render.

Render All is a feature that allows you to render all the SketchUp scenes in a model in sequence.
When invoked, Render All, renders each scene and saves the image in the SU Podium image
save folder. This enables you to batch render several scenes in sequence or even create photo-
realistic animation especially if you have created the SketchUp scenes using SU Animate

For SU Podium V2, Render All is still in beta. It must be downloaded from the Registered User or
Download page of this web site. There is an install .exe file for Windows and an install .zip
package file for the Mac.

Render All V2 will render object movement from scene to scene so it can be used for object
motion type animations. Render All V2 has a convenient user interface that allows you to pick the
scenes you want to render. First click None to turn off all the Scenes in the Render All dialog box.
Select the scene from the Render All UI and hold the shift key down and select the final scene in
the sequence. This works just like SketchUp's Scene Manager.
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Back to the Top of RenderAll

Render All saves each rendered scene's image to a designated folder that you have chosen in
Podium V2 Options dialog box. When it is complete, you can take all the images that were
rendered and use Windows or Mac programs like Movie Maker or iMovie to create a video
animation. The idea is that each scene in SketchUp is like a frame in a movie. When each scene
is rendered with Render All, each JPG or PNG image can be used as a frame. When "stitched"
together with Windows Live Movie Maker or Mac's iMovie, a video animation is created.

Render All will use the settings in your current Options dialog box such as Preset, Image Size,
Save location, and all the Environment settings. It's a good idea to render one or two scenes
before committing to the Render All process. Once you start the Render All process, it is not easy
to stop Podium from rendering the list of scenes, especially on the Mac.

Render All is in beta. There are some bugs and problems that this web page will go over.
However, you can get some good photo-realistic animation results such as the below videos. The
photo-realistic quality if Podium V2 quality. Podium V2's Global Illumination is 2nd to none.
However, Render All takes patient to achieve even modestly successful object animations. If you
are only interested in walk-thru type animations and are a Windows user, please consider SU
Walk or PodiumWalker as a much easier alternative. SU Walk is available now. Podium Walker
will be in beta and also being ported to the Mac.

Mac version of RenderAll V2- please note: There is a bug in SketchUp which effects RenderAll
that may infuriate Mac customers. What happens is SketchUp will hang up (stop paging) on a
scene in your animation. But RenderAll will continue to force Podium to render which results in
one scene getting rendered over and over. You may find your self having Force Quit Podium's
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OOPR and SketchUp and restarting RenderAll at the scene that SketchUp stopped paging.
However, with the new user interface, you can easily highlight the scenes you want to render. So
starting over from a specific scene is easy. First click None to turn off all the Scenes in the
Render All dialog box. Then click the scene you want to start rendering from. Hold the shift key
and click on the scene that will be your last scene. This action will highlight all the scenes that
you want to render.

This video was made from a SketchUp model created by Kumise Landscape Design. It was
rendered by Cadalog, Inc. using SU Podium V2. The animation was created using SU Animate
V4. Then with SU Podium V2 and RenderAll V2 Beta 100 image frames were created. These
were then created into a movie using Windows Live Movie Maker.

Back to the Top

This video was made from a SketchUp model created by Nicolas Harvey, SU Podium V2 tech
support. It was rendered using SU Podium V2. The animation was created using SU Animate V4.
Then with SU Podium V2 and RenderAll V2 Beta 100 image frames were created. These were
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then created into a movie using Windows Live Movie Maker. The flickering is a result of the
shadows and global illumination in SU Podium V2. There is less flickering if shadows are turned
off.

A variation of the first video but with sound and different reflection settings.

Back to the Top

Using SU Animate to create the SketchUp scene animations

Please visit the SU Animate web site to learn how to create scene based SketchUp animations.
SU Animate is a SketchUp plug-in that provides a very easy way to make walk-thru, timeline,
spiral or object motion animations in SketchUp. The final step of SU Animate is to create
SketchUp scenes so that SketchUp can run the animation.

One very important item to note when you use SU Animate for object motion animations. In the
above example of a car driving through a Japanese town, the scenes were created by SU
Animate's Path Animation. This method of object animations will result in a SketchUp model that
is several times larger than the original SketchUp model because the animated object is copied
to all the scenes. Then layers are turned off and on for each scene. When you use RenderAll on
a model with this type of animation, be aware that the model is much larger than it original was.
Possible two or three times larger. This can take hours to complete the Render All process
depending on the number of scenes and the complexity of the object motion animation.

Windows - Stop running Script error

With very large models that have hundreds of thousands of faces or more, you will most likely run
into a Windows Stop running Script prompt.
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You must respond No to this prompt for Render All to continue. So if you plan to leaver your
Render All running all night while you go home, you may find this Windows prompt on your
computer when you come back to the office in the morning. Be aware of this. It may mean for
large models with hundreds of scenes, you may have to be monitoring it's progress and click No
on this dialog box periodical to have Render All continue. We are investigating the cause of the
problem.

71 SU Podium V2 Help and Tutorials



An Introduction to Photorealistic Rendering in SketchUp using
SU Podium V2

Table of Contents
Part One - Overview

Part Two - Textures

Part Three - Lighting

Part Four - Geometry Detailing

Part Five - Night Rendering

This is the first in a series of articles which will go through how to produce realistic renders. Each article will focus on a
particular aspect or rendering, and how to use Podium to deal with each of these aspects in terms of creation of a realistic
image from a very simple scene.

Part 1 - Overview
If you are still reading, you will not only be interested in creating more realistic images of your SketchUp models, but you will
also have a reasonable attention span! Some issues benefit from a little detailed explanation, but in all cases we’ll try not to
go into any more detail than absolutely necessary.

It is aimed at the beginner to intermediate SketchUp user. It assumes you will have a degree of familiarity with SketchUp,
and will be using groups, components, and drawing to scale. If you aren’t using these features in SketchUp, you need to
learn how to use them, they are essential to effective modelling and rendering. It will take you from creation of a simple
model, to rendering a fairly realistic image, by covering all the fundamental aspects of rendering.

First of all, what do we mean by ‘photorealistic’ rendering? This question is not as easy to define as you would think. At its
simplest, one could define it as the creation of computer-generated images which look like photographs. This is very, very
difficult indeed. It depends on accurately simulating the appearance of material properties, geometry, lighting, and camera
effects. There are some excellent examples here.

The basics to creating great renders are to use high quality textures, an appropriate level of detail, and to set the lighting up
correctly.

If we first consider materials, you might think that objects only have a very few basic properties like surface roughness or
smoothness, colour, transparency and reflectivity. This is only partly correct as we will see later.

With geometry, real objects have lots of irregularities, some are immediately evident, like warping, cracking, bending and
misalignment. Others are very subtle and might not be immediately apparent if you aren’t looking specifically for them. The
most obvious example of this is edges. Most people will model these as simple extruded shapes with sharp corners. If you
look at a table for example, where the top meets the edges, there will almost always be a slight rounding. It’s not sharp like
a knife edge, there is a small curve. If you look at Figure 1 below, you’ll see that both the table and the tissue box don’t
have sharp edges, and there is a soft blurred or highlighted edge instead of a sharp one.
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Figure 1. example of soft edges

This changes the way the light falls on and reflects off surfaces. Little details like this can make a noticeable difference.
Simulating this accurately would be very complex and time-consuming, but there are some tricks to getting great results
without overdoing the detail.

With lighting, there are two basic types, direct and indirect. Direct lighting comes straight from the light source, indirect
lighting is when the light bounces off surfaces onto neighbouring surfaces, causing shadows and illumination where you
might not quite expect to find them. Figure 2 below shows both direct and indirect lighting.  
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Figure 2. Direct light

Figure 3 below illustrates indirect lighting very well. There is no direct sunlight at all, but the indirect light  from the sky is
bouncing down the deep narrow gap between the buildings and illuminating the walls, the street and even the underside of
the balconies!

Figure 3. Indirect light

If you want to create really good renders, you need to balance direct and indirect light.

Finally, with photographs, there are particular features that are introduced by the camera that influences the final image. For
example there might be lens blur, lens length or camera flash.

Simulating these things accurately involves a fairly detailed knowledge of each element, which is a lot of learning, yet people
produce supposedly photorealistic images without all this detailed knowledge. How is this so?

To go back to the question posed earlier, “What do we mean by photorealistic rendering?”, the short answer is that in
computer generated imaging, the term ‘photorealistic’ is relative, and is generally used to refer to the creation of images that
look realistic as opposed to identifiably computer-generated. The main SUPodium home page video rather conveniently
shows this very clearly and Podium has been designed to make the creation of these types of image as quick and easy as
possible.

The next article will deal with the creation of a simple scene for rendering, which will be used to explore the principles
outlined above.

Happy rendering!
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Back to the Top of the Tutorial

Part 2: Textures
This is the second in our series of articles which will go through how to produce realistic renders. Each article will focus on a
particular aspect or rendering, and how to use Podium to deal with each of these aspects in terms of creation of a realistic
image from a very simple scene.

Part 1 was a general overview, this article goes into more detail about Part 2, Textures.

Good textures are vital to high quality renders. Generally speaking, the better your textures, the better your renders will be.
They can make up for lack of detailed geometry in a scene, and this is particularly evident in computer games, where
polygon count needs to be kept as low as possible to improve performance and increase the amount of detail in the scene
as a whole.

We’ll start by taking inspiration from a photograph. Modelling photos is a great way to develop your skills.

The photo below was taken from the Architecture and Design blog The Absolution.

        Figure 1. Source photo    

We are not going to try to duplicate it exactly, because modelling the furniture is going to be an exercise in itself, and rather
more complex than necessary for a basic introduction!

I have modelled the basic structure which you can download from this web page here. I have applied the standard glass
Material from the free section of the Podium Browser, and a water texture from SketchUp’s standard library. (Automatic
materials in the Podium Settings dialog is on.)

Before we add textures, this is how it renders with the clay option turned on.
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       Figure 2. Untextured clay render model 

I have used the 1.0.5 exterior default preset and turned sun intensity and exposure sliders right down because the render
will be too bright for clay renders. I have turned the physical sky off for now.

It’s close enough for the moment, so we’ll start to add some textures. To start with, let’s use some from the Textures folder
of the Free section of the Browser. I have applied a stucco texture (stucco_02) and a concrete texture (concrete_09) for the
floor and a tile texture (tiles_44) for the interior floor. First of all you’ll need to scale the textures up a little. I’ve used a scale
factor of 500mm. 

I’ve assigned a little bump (value of 20) to the stucco and concrete, and blurred reflection (D/T/R 90/0/10) for the tiles.

The textures in the Free section are pretty good in that they are mostly seamless. However you can see that they have
noticeable patterning. Let’s render this and see how it looks. First we’ll need to reset the Sun Intensity and Exposure sliders
and turn Clay off in Podium Settings. 
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       Figure 3. Render of textured model

So, although they don’t have ‘seams’ in the sense that you can’t see the edges of the image being tiled, they aren’t truly
‘seamless’ in the sense that you can see repeated patterns caused by patches of light and dark in the texture.

The only way to cure this is to either modify the texture in your image editor, or use a larger or genuinely seamless texture. 

I spent some time using Google image search with a large size filter for the term ‘plaster texture’ and found something much
more suitable on dextroduction. A little work in Photoshop with the high pass filter and the clone brush to remove the
vertical and horizontal seams, and we have something a little more convincing.

       Figure 4. Render of re-textured model

In the original image, the water is darker. This means it is either reflecting  dark colours or the pool tank below the surface is
dark. Considering the colour of the sky and the brightness of the scene, it is most likely to be the latter.
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Let’s see what we can do to fix this. Let’s move the water plane upwards and re-texture the inside surface of the pool with a
darker colour. Let’s try a popular choice for pools, blue mosaic tiling. From the Podium free textures section I have used
tiles_25. Let’s see how this renders.

        Figure 5. Render of textured model 

This is looking pretty good for the moment. The wall and floor textures are reasonable, the pool is looking a little better, and
the whole scene is starting to look reasonably like the source image. We’re effectively done with texturing for the moment. 

The next article will try to get even closer to the source image and deal with lighting.

Back to the Top of the Tutorial

Part 3: Lighting
This is the third installment in our series of articles which will go through how to produce realistic renders. Each article
covers a particular aspect or rendering with Podium to create a realistic image from a very simple scene. As mentioned in
the last article, this tutorial is definitely not about getting something indistinguishable from a photograph, it’s about creating
an image that looks convincing, to learn about how to approach rendering.

The basic principles of rendering (textures, lights, detail) are easy enough to grasp, but knowing exactly what this means in
terms of setting up your scene for rendering is not quite as straightforward. These articles don’t deal with creation of jaw-
dropping, stunningly realistic images, that takes a lot more practice and attention to detail. These articles are aimed at taking
novice or intermediate users up to a decent level of proficiency that they can use for general rendering, or use to build on to
push their skills further in pursuit of even higher standards of realism.

There are two basic types of lighting, direct and indirect. Direct lighting is where you have a light source which casts light in
a straight line from the source. This generally creates sharper, more clearly defined  shadows, and all other things being
equal, is brighter than indirect lighting.

Examples of direct lighting are the sun and light fittings. 

Indirect light is bounced (or reflected) off something else and onto an object. Most surfaces reflect a proportion of light that
falls onto it. In fact there aren’t many surfaces that absorb all light. 
Indirect lighting is the reason that rooms are not completely dark apart from the patches of light cast by the sun that enter
through windows. 

Figure 1 (porto Covo Palace in Lisbon, more info here) below shows a very good example of both direct and indirect lighting.
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Figure 1. Interior with both direct and indirect lighting 

On the left hand side of the photo you can see the patches of sunlight which is direct light. However the left hand wall and
the ceiling are both illuminated, and there are shadows on the ceiling. You can clearly see that shadows are cast by light
coming in through the windows on both the left and right hand sides of the picture. You can see that the light on the left is
clearly stronger than the light on the right, but where is the indirect light actually coming from?

Figure 2 shows this in a visual way.
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Figure 2. Simple analysis of light sources 

Generally sunlight bounces off clouds, the atmosphere as well as other surfaces.

If we go back to the the test scene, we can see that the scene is lit mostly by indirect light. You can see that there is a
cloudy overcast sky, which generally means that sunlight will be diffused by the clouds, shadows will be softer and less
intense, and light will not be as strongly directional. In addition, the light is bounced off the light coloured walls to create an
evenly-lit scene.

     Figure 3. Original source photo    

If we take our textured test model downloadable from here, turn the shadows off and render it with the 1.0.5 exterior_default
preset, we get the result shown below.
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       Figure 4. Rendered image with 1.0.5_exterior_default preset  

The most noticeable thing about this image is that it’s too dark compared with the source image.
Note that the physical sky only works when the shadows are turned on, and when there is no sun in the image, the sun
intensity and exposure sliders don’t work.

We don’t know whether the photographer has post-processed the source image to adjust the exposure brightness or
contrast, so what looks to be a ‘realistic’ image (because it’s a photo!) may actually have been enhanced. We can do a
similar thing and adjust the image with an editor.

About 30 seconds work with the Mac’s built-in image editor in Preview gives us the result below. For Windows users, you
can open the image in MS Office 2010 and apply similar color filters.

       Figure 5. Above image with post-processing. 

This isn’t too far away, and the easiest solution would to spend a little more time with adjusting the lighting and colour
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balance to get it closer. However, this wouldn’t be much of a tutorial if we simply left things there!

Let’s try to use a different preset and see how that changes the image. We’ll try using the 1.0.5 interior_default preset. This
seems counter-intuitive. Why do we want an interior preset with an interior scene? Won’t it be too bright? The interior
presets boost the overall ambient lighting levels, which you need for interiors.

Figure 6 below shows the result.

         Figure 6. Render with 1.0.5 interior_default preset 

This image is noticeably brighter than with the exterior preset, but it’s not too over-exposed.
The walls are a yellowish colour which doesn’t quite match the source photo. We can fix that.

You will notice that without the Podium physical sky, we have no sky colour. Let’s make sure the ‘Podium Physical sky’ box
is unchecked (it doesn’t make any difference with shadows turned off, but for the next stage, we want to make sure it’s
turned off.)

We’ll set the SketchUp background to a solid background, instead of a SketchUp gradient ‘sky’. Let’s choose a light blue
colour and render.
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     Figure 7. Same scene as above, with blue SketchUp background colour 

Not bad for 1 minute and 45 seconds on a laptop! 

To get the sky, let’s try using the transparent png option. In Podium’s Settings dialog, Switch to the Output tab, choose the
png format, and check the ‘Transparent’ box.

This effectively ‘cuts’ out the background sky, so it’s easy to add a background in Photoshop or most image editors that
support transparent .png.
I have added a sky I found on allcgextures.com and tweaked the levels a little. Figure 8 shows the final result.

Figure 8. Same scene as above, with Sky image for the background.

It’s not an exact copy by any means, but it’s a fairly realistic approximation of the basics.
Although we have a solid base to start working with, it’s also important to realize that we’re not done yet!

We have covered textures and lighting, the next articles will deal with geometry detail, and adding additional touches to the
model and rendering night scenes.

Back to the Top of the Tutorial
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Part Four: Geometry Detail
This, the fourth installment in our series of articles on creating realistic renders deals with modelling. We have already
covered the basics, lighting and texturing, this time we are covering the the level of detail in your model, based on a very
simple scene.

To reiterate the points made in previous articles, this tutorial is definitely not about creating a render which is
indistinguishable from a photograph. That is difficult and requires a much more in-depth approach, and much more attention
to detail. These tutorials deal with creating convincing images, to start people thinking about how to develop their skills to
improve their Podium renders.

It ought to be obvious that you can’t start out with the very simplest of models, texture them nicely, set up the lighting
properly and you will end up with something that genuinely looks real.

The Podium Browser makes it easy to set up your materials, and add good render-ready components, however this doesn’t
mean that you don’t need to put in much effort with the base model!

It’s not particularly perceptive to say that there is a balance to be struck between adding massive amounts of detail to
everything, and adding hardly any. The closer you are to the model, the more detail you need. Similarly, objects further
away from the camera need less detail. 3d games engines have components which have different levels of detail, which are
switched on and off based on the distance from the camera. The fully-detailed trees with all the leaves and branches turn
into 2d billboards when they are distant.

When working out how much detail to add, you also need to think about exactly what you want to achieve. The more realistic
you want to get, the more detail you need to add, but the longer your scene will take to render.
I think that for most people, a simple principle is to use only as much detail as you need.

It takes a little time to work out what this is, and it is different for most people. Generally people tend to render a particular
type of scene for a particular purpose, so once they get an approach they are happy with, they will tend to use the same
approach for every scene.

This article focusses on lots of little things that people miss.

This is the scene we are trying to copy.
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Figure 1. Original source photo       

This is the scene we ended up with at the end of part 3.
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Figure 2. The pool scene after texturing, lighting, and adding the background in post-processing

It’s a reasonably realistic starting point, so let’s add some detail and see how we get on.

First of all I’m going to round the edges of the pool surround. In reality, not many surfaces have really sharp edges. If you
think about it, sharp edges generally occur when materials are cut and/or ground. Wooden items can have sharp edges
when cut, but you almost always have a slight rounding applied to them to prevent the sharp edges splitting. Items that are
moulded, almost always have rounded edges, because most moulding processes aren’t accurate enough to get really sharp
edges. Cast glass tends to have smooth ground edges to prevent people from cutting themselves. You’ll find the same thing
on plastered walls.

The significance of this for rendering is that slightly curved corners reflect the light in a subtly different way. You don’t
necessarily notice this unless you look for it, but the softness and realism of the edge highlights will make a difference in
virtually all of your scenes.

The image below shows a new component for the browser, the Ikea Hol table.

Figure 3. The Ikea Hol table component, modelled and rendered simply

This component has been built as simple extruded surfaces with holes, and the texture applied to the whole component. It
looks okay, and if you see how it looks from a distance, you can’t see that it’s not very sophisticated.

Figure 4. The same component rendered from a distance
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Render time with this simple component is pretty good, however the close-up view isn’t good enough for a realistic render.

The first thing we need to do, is work on the texture. In reality, the wood grain virtually always runs along the long direction
of a component. You can see the real photograph here. You can clearly see that the table is made up of individual pieces of
wood, fitted together. Look at the direction of the wood grain. Let’s modify the component to show this.

Figure 5. The same component modelled with individually-textured components

This is a big improvement, and render time has increased, but we can do better. Look at those sharp edges at the top and
on the corner. Let’s soften those. I use the Roundedge plugin by Fredo downloaded from the ‘Plugins’ section of the
SketchUp forum. This makes adding bevels and curved edges very quick and easy. It works fine with Podium and it’s one of
my most frequently-used plugins.

The trick is to make sure you don’t add too many polygons unnecessarily. I have applied a 0.5mm edge with a single
segment, (effectively a chamfer) along the vertical corner member.
to the lid I have applied a 2mm rounding with 2 segments. The geometry has been smoothed to make the curves look more
natural and help with texturing.

I have also added tenon joints at the top, where the timber sections join. The render for this is shown below.

Figure 6. The same component with rounded edges

Render time has increased again, but the component looks much nicer. each of the elements is a component, which keeps
the file size down for the Browser. We could improve the component even more by creating more variations on the slat
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members, and changing the texture, so that the wood grain is more realistic and less regular. You can particularly see the
subtle highlight on the top edge of the lid and the tenon joints. With a little more texture variation, the component would look
even more realistic.

Having demonstrated the point about texture variation, detail and curved edges, let’s return to our test scene. Concrete
generally has slightly rounded edges, because it tends to crumble when too thin, and ‘normal’ construction concrete doesn’t
have sufficient strength to keep really sharp edges.

I have softened the edge of the pool and the copings around the roof. Let’s also add some skirting boards internally, and
some door handles.

The next stage is to add the furniture. I spent a little time building some similar items, and found a cactus model on 3DW
which I textured and modified. The petals are dynamic components I built and distributed manually in a similar way to the
photo.

Figure 7. The base model with more detail and additional furniture components

This scene has been rendered with the QMC preset, with the Podium physical sky on, and the transparent png background
option. It’s not bad, but it we look at the door threshold and the amount of light inside the room, they are not quite right.

To increase the light inside, there are 2 options, cutting openings (because we don’t know how where the light comes from
in the actual building in the photos) and adding LEMs. I have chosen the first option. You will also notice the area of wall
above the lower roof on the right is a little overexposed. To fix this, I have darkened the colour of the roof, which will
bounce less light off it and help to reduce this. You can download the modified model from here.

Download the Final Pool model here.

 

Figure 8. The same scene with additional lighting introduced into the interior space

This is a definite improvement. However we still need to add the sky in post-processing. At the same time we’ll adjust the
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brightness and contrast, and resize the image, because the QMC presets introduce noise or ‘graininess’.

The final image is shown below.

 

Figure 9. Final render with post-processing

We have adjusted the colour balance, saturation and contrast, and added a border.

The image could undoubtedly be improved even more with more sophisticated post-processing. With a solid understanding
of blend modes, adjustment layers you can significantly improve any image. I’m not very good at post-processing, so I tend
to limit this to the basics!

It’s not an exact replica of the original scene by any means. In particular, the wall texture and floor textures are much
cleaner, but it’s a decent image, and shows how that to make your images that little bit more realistic, the better they get,
the harder you have to work to improve!

So far we have covered all the basics of rendering. These tips will not turn you into a PeterGuthrie or a RonenBekerman,
but they will help you start to improve your renders.

In the final article, we’ll try to create a convincing night version of the render.

Back to the Top of the Tutorial

Part Five: Night Rendering
This is the final document in our series of articles on creating realistic renders with Podium. Previous artcles took you
through lighting, texturing and levels of detail. This final part deals with night renders.

If you have been following the series, you will see how we started by trying to learn by copying from a photograph. We
started with a very basic scene and gradually added more detail to it, carefully observing the source photograph, and trying
to emulate it.

As we stated in all the other articles, the series doesn’t deal teach you how to create a proper ‘photograph type’ realistic
image. They are starting point for people to create really good renders as a starting point for people to develop their skill
levels.

Night renders are images that many users struggle with. We are going to adapt our scene to create a night image.

Previous articles have involved adding content from the Browser. This time we aren’t doing this, we are going to rely mainly
on adding LEMs to simulate indirect lighting from sources which aren’t in plain view.

This tutorial will just cover the basics of setting up a night render, and give you some basic information to experiment
further.
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Figure 1 below shows what we have got so far. It’s a simple, fairly convincing daytime render. Let’s start to turn it into a
night image.

 
Figure 1. Final render with post-processing 

The starting point for a night render is to set a dark background colour in SketchUp. The Podium physical sky only works for
daylight hours, so for night renders we have to rely on SketchUp’s background options. By default, the most recent versions
of Podium come with some background styles for night renders. If you go to SketchUp’s Styles palette, you should see a
category labelled ‘Podium’. 

There are  a number of night styles to choose from, with varying degrees of darkness. Figures 2 and 3 show how they
render. In these images, we have set the sun brightness and exposure sliders to their minimum values.

Let’s start with the the ‘Dark night’ Podium style. Select this as the SketchUp background in the ‘Styles’ dialog. Turn the sun
off and render with the 1.0.5 exterior preset

 
Figure 2. Render using the ‘Dark night’ SketchUp background style from Podium 

That’s pretty dark, and there are no lights in the scene, so all the light is coming from the sky, which is black!

When we choose the ‘Night_1‘ style, we can see from figure 3 below that we can make out some details in the scene.
Because the background is lighter, we have more light bouncing around the image illuminating the details.

How much detail you can see in the scene will depend on your monitor’s gamma settings, and the angle at which you view
the image on your screen. Although this sounds strange, if your monitor is reflecting too much ambient light around you, you
won’t be able to pick out the contrast and the details in the render. You should be able to see the pool, the plant in the
corner, the glazed screens, and you should be able to just about make out the square window right at the back of the
scene. 
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Figure 3. Render using the ‘Night 1’ SketchUp background style from Podium 

Let’s add some light sources. The easiest way to do this is to add LEMs out of sight to simulate light sources which are not
visible in the scene. I have added individual large LEMs with a strength of 40  out of view. There is one in front of the walls
to the left and right walls, and one in the room at the far end of the view below the ceiling.

I have also made them invisible in case any of the edges show in any views.

LEMs are generally much better than omnis for this. They produce softer more subtle light, and you need fewer of them.

This is how the scene renders with the LEMs.

 
Figure 4. Render with ‘Night 1’ background style, with LEMs inside the building 

You might want to experiment with the LEM light strength until you are happy with the effect.

You can see how the light floods out of the openings, bounces off the walls and the water, and is casting a shadow on the
wall behind the cactus plant. This scene uses only 4 LEMs inside the building to light it. There are no light sources at all in
the front courtyard.

Now that we have some light sources in the scene, we can switch back to the ‘dark night’ style, and see how that renders.

91 SU Podium V2 Help and Tutorials



 
Figure 5. Render with ‘Dark Night’ background style, with LEMs inside the building 

We can see that the sky is much darker, which might be more appropriate for areas in the countryside late at night, where
there is less light pollution, and all the ambient light is from the stars.

Obviously the sky is seldom completely black, so we will want to add a background. Let’s use the transparent png output
option, and add the background in post-processing.

The transparent png option produces the image shown in Figure 6 below. The white ‘sky’ is actually transparent, and the
page background is showing.

 
Figure 6. Render using transparent png background options 

We can go into our image editor, and paste a night sky photograph into the background to produce an image like this.
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Figure 7. Image with ‘Dark night’ style and post-processed night sky 

This works reasonably well, because the background in the starry sky is similar to the original plain SketchUp background
colour.

Many people might think that night skies are simply dark blue or black, but there is a lot of beauty and subtlety to them, and
choosing the right one to match your render is very important. If we go back to the ‘Night 1’ style and render with the
transparent png option, we can see the different effects achieved by using different background images.

 
Figure 8. Image with ‘Night 1’ style and post-processed night sky 
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Figure 9. Image with ‘Night 1’ style and alternative post-processed night sky 

 
Figure 10.  Image with ‘Night 1’ style and alternative post-processed night sky 

Let’s add the furniture back in and add some light fittings. I’ve added two Optelma Taso3 wall lights from the free fittings
section.

The first image below shows the complete image, with an added background, using the default option for soft omni lights,
which is to disable them..
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Figure 11.  Image with light fittings - soft omnis off

Let’s turn on soft omni lights and see how this changes the render.

 
Figure 12.  Image with light fittings - soft omnis enabled 

You can see that the overall illumination level is slightly higher, with a broader spread of light, and the the falloff of the light
is softer in the second image. It’s a slightly nicer image, but render time has increased from 3m5s to 4m 34s. An increase of
33 seconds even without all the furniture seems a lot, but render speed can vary even if you render exactly the same scene
several times. It depends what background operations or programs are running. Although the quality increase in this image
is marginal, different fittings will produce different results.

Turning on soft omni lights is a global setting, so before you enable this option, you ought to test render speed with just a
few fittings first and carefully assess whether you think it is really worth the extra render time.

It is worth underlining that adding lights, particularly in conjunction with lots of reflective surfaces, can substantially increase
render time. We have gone from a render time of around 1-2 minutes for daytime renders, to 4-5 minutes for night scenes.

The additional render time is an indication that your hardware is working harder. More lights and more reflective surfaces
increase the number of calculations that the render engine has to perform. This requires CPU time and RAM. Different
presets also affect render speed. 

The ‘high’ and ‘QMC’ presets require more system resources. The ‘high’ presets have enhanced anti-aliasing (edge
detection and smoothing) and the QMC presets have improved accuracy but also have a slight graininess or noise to the
image. 

Unless you want to needlessly increase render time, only use the ‘high’ presets (1.0.5_exterior_high.pps and
1.0.5_interior_high.pps) for images where you have very fine details like shadow gaps and cables. QMC presets are for
where the standard presets are creating weird splotches, or you want better accuracy and have the time to wait.

The final image is shown below with a little post-processing. You can download the scene to see how things are set up
here.  

Download the Final Pool (night rendering) model here.
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This concludes our series of introductory articles on photorealistic rendering.

Have fun experimenting with your Podium renders!

If you have any questions, want any tips to improve or just want to show us what you can do, please post on our forum!
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Automatic Materials is an option introduced with SU Podium V2.9. It is available in the SU Podium Options
dialog under the Environment Tab. When Automatic Materials is on, SU Podium understand that certain
SketchUp standard materials will be assigned pre-defined Podium photo-realistic material properties. Using
this option can save you time in applying good reflection, blurs, refraction or bump properties to materials if
you are using SketchUp standard materials.

Learn about Automatic Materials in the Automatic Material video tutorial or go to the Help Video web
page.
You can also link directly to You Tube to get a larger resolution here.
If you can not view You Tube, here is a link to Windows Media file that will be loaded into your
browser.
MP4 version

How Automatic Materials work - only with SketchUp standard materials

This model's reflections was automatically applied. Click on image to view much larger resolution.

When automatic materials is on, Podium will recognize SketchUp standard material names in a model
and automatically assign pre-defined reflections, blurs, refractions and bumps to these materials. The
Podium properties were pre-defined by Cadalog's team of developers and testers.

The list of SketchUp standard materials that will be assigned Podium properties is in the materials.csv
file which is located in the SU_Podium_V2 \preset folder. However, we strongly recommend that you
do not edit this materials.csv file for you may lose automatic materials.

Once Podium recognizes a SketchUp standard material name, it will assign the Podium properties that
are defined in the materials.csv file. For example, the brick_antique material in the SketchUp Brick and
Cladding category is assigned a bump value of 80, automatically.

Automatic Materials
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What are SketchUp standard materials?

Automatic materials only work with SketchUp standard materials. These are the .skm texture files
found in the SketchUp materials browser. These are the materials that come standard with SketchUp.
There are several categories of SketchUp materials.

Note: The .skm files are compressed .jpg texture files that are located in the \Google SketchUp
8\Materials\ folder.

Automatic material properties do not get saved to your model

Automatic material properties do not get saved to your SketchUp model. You can easily tweak the
automatic material property settings or save the settings permanently, by click on the Apply button in
the Podium material dialog. Once you click Apply, the Podium properties will be saved with the
textures in your model.

Turn Automatic Materials off if you do not want them

If you prefer to assign your own Podium photo-realistic properties to SketchUp standard materials,
you can turn Automatic Materials off. Open the Options dialog and select the Environment tab. Check
off the Automatic Material box.

Imported materials do not have automatic materials

Very often, you will want to use higher resolution textures than what is available in the SketchUp
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standard material categories. For this reason, Cadalog has made available free texture libraries in the
SU Podium Browser. However, these textures do not have automatic materials assigned to them. You
will need to Apply your own Podium properties to any texture/ material imported into SketchUp. In fact,
many 3D Warehouse models that you will import will not have SketchUp standard materials.
Furthermore, the Podium Materials in the Paid section of SU Podium Browser do not have automatic
materials assigned to them.

Textures on reverse or back side faces

As with all materials in Podium, it is a good practise to place the material on the front side of a
SketchUp face. Click to read about Front Side (Normal side) and Reverse side (Back side).
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